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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Before you start

The Getting Started Exercises provide a quick way to learn the 
Cerity Pharmaceutical QA/QC application. Use the Cerity 
Concepts Guide to help you do the tasks in these exercises.

Setting Up Methods 

If you develop methods for your laboratory, you should go 
through these exercises. You can use these methods to run 
samples and sequences with the Running Routine Samples 
exercises. 

Running Routine Samples

If you run samples but do not develop methods, you can do 
these exercises with the default methods that come with the 
Cerity Networked Data System, or you can use the methods set 
up with the Setting Up Methods exercises. 

Before you start 

Make sure that you or your administrator transfer the default 
methods and example chromatogram from the Cerity CD-ROM 
to the database. For details to transfer the methods and make 
them usable for your system, turn to the next page.
5Agilent Technologies



Step 1. Restore the default methods

The default methods for the Basic and Advanced exercises are 
located on Cerity software CD in \GettingStarted\DefaultMethods. 

1 Restore the default methods.

The default methods for the Basic and Advanced exercises 
are located on Cerity software CD in \GettingStarted\
DefaultMethods. 

2 Select Start > Programs > Agilent Cerity > Administration and 
Maintenance > Archive and Restore.

3 Enter logon information and click OK.

4 Select Restore, and click Next.

5 Click the ...  button.

6 Select \GettingStarted\DefaultMethods\Basic (or \Advanced) on 
the CD-Drive.

7 Click OK, click Next, and click Yes to the messages.

8 Click the >> button to move the default methods to the 
Restore Objects list.

9 Click Next, click Start, and click OK for each message that 
appears.

The following message appears: “These tables contain 
duplicates”.

Step 2. Resolve database duplicates

1 Click Next.

2 Make sure that the Select instruments to enable check box is 
clear.

3 Click Next and select the second Administrator role.

4 Click Rename, enter the new role name Admin and click OK.

5 Click Next, click Start, and click OK.

6 Click OK and any Close buttons.
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Step 3. Restore the example chromatogram

The example chromatogram is on Cerity-CD-1in \GettingStarted\
DefaultResults. Make sure that the default example 
chromatogram has been restored.

1 Repeat step 1 through step 4 in “Step 1. Restore the default 
methods” on page 6.

2 Select \GettingStarted\DefaultResults on the CD-ROM drive, 
click OK, and click Next.

3 Select defexchrom2a, click >, and click Next.

4 Click Start, click OK to the messages that appear, and click 
Close.

5 Select Start > Programs > Agilent Cerity > Cerity Pharmaceutical 
QA/QC.

6 Enter logon information and click OK.

7 Select Result from the Current View list.

8 Select AllResultsRestored from the Query list.
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NOTE

Step 4. Copy the default method to use with your instrument

Refer to “Basic Exercise #2 Set up a method for single samples 
to identify compounds” on page 81 if you need to.

1 Select Method from the Current View list.

2 Select AllMethodsRestored from the Query list.

3 For each default method:

a Select File > New > Method.

b Click Browse, select defaultmethodN for Basic exercises, or 
AdvdefaultmethodN for Advanced exercises, and click OK.

The first time that you copy and 
rename Advdefaultmethod4, name 
it defexer4a. The first user will 
alter this method in Exercise 4b. 
You must then copy 
Avdefaultmethod4 and rename it 
defexer4b for the second user to 
use the method.

c Name the new method defexerN, and click Next.

d Select the instrument where the method will be used, and 
click Next.

e Click Next until you reach the New Method Review panel.

f Click Finish, and click Save when the Save to the database 
message appears.

4 Select AllMasterMethods from the Query list.

5 Expand defexerN.

6 Expand Instrument Setup, and adapt the settings.

7 Adapt the instrument settings for the non-matching LC 
modules. 

You can use the default methods ONLY on instruments with an 
Agilent VWD detector. Your other LC modules do NOT have to 
match the modules on which the default methods were set up 
(autosampler, quaternary pump, thermostatted column 
compartment).

If you have no instrument available with a VWD detector to use 
with these exercises, then the administrator or advanced user 
should set up the methods using the Setting Up Methods 
sections in this guide.
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Running Routine Samples

These exercises help you learn how to run routine samples. You 
can use the default methods for the “a” exercises or set up 
methods in the Setting Up Methods exercises. You must have 
results from the “a” exercises to do the “b” exercises. The set of 
basic and advanced exercises includes the topics below:

Basic Exercise 1 – Equilibrate the instrument Learn how to equilibrate 
the instrument with the instrument panel or with a method.

Exercise 2a – Run a single sample to produce an example 
chromatogram Learn how to produce an example 
chromatogram that you can use to set up integration and 
identification in a method.

Exercise 2b – Run a group of single samples to identify compounds
Learn how to enter and run a group of single samples with a 
method to identify the compounds in the sample.

Exercise 3a – Run a sequence to quantify compounds with 
single-level calibration Learn how to run a sequence with 
single-level, single-update calibration, ESTD quantitation, and 
fixed amounts.

Exercise 3b – Reintegrate and reprocess the results Learn how to 
manually reintegrate the sequence results, and reprocess the 
results with the original method revision. For more information 
on running routine samples, see the Concepts Guide, “Sample 
Analysis”.
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Advanced Exercise 4a – Run a sequence to quantify compounds with multi-level 
calibration Learn how to run a sequence set up for multi-level, 
overall calibration, variable compound amounts and sample 
variables.

Exercise 4b – Change sample variables in the method and 
reprocess Learn how to reprocess the results with the most 
current version of the method and a version with new sample 
variables.

Exercise 5a – Run a sequence to quantify impurities Learn how to 
create and run a sequence set up for ISTD quantitation, custom 
calculations, limits, bracketed calibration and system 
suitability.

Exercise 5b – Use a different method to reprocess Learn how to 
reprocess with a new method.

Before you start Read “Before you start” on page 5.

If you plan to use default methods in these exercises, make sure 
that these methods are in your database. From the Query list, 
select AllMethodsRestored to view defexer1-5 or 
AllResultsRestored to view defexchrom2a.

Your system administrator must have configured an Agilent 
1100 LC series liquid chromatograph for your system. 

If you choose to do the Running Routine Samples exercises with 
the default methods, you must use an instrument with a VWD 
detector. If you use the methods created in the Setting Up 
Methods exercises, you need only an autosampler, pump 
(quaternary or binary) and UV-Vis detector (VWD, MWD, DAD).

Solvent A is water. Solvent B is methanol or acetonitrile. 

Use Agilent Technologies column Eclipse XDB-C8 (or C-18), 
4.6MM X 15 CM (5µM). 

Prepare the following three vials of the isocratic standard, 
Agilent Part # 01080-68704: undiluted, diluted by factor 2, and 
diluted by factor 4.
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Basic Exercise #1a
Equilibrate the instrument

This exercise contains a series of tasks to help you learn how to: 

• Equilibrate the instrument with the instrument panel in the 
Cerity Pharmaceutical QA/QC application

• Enter and run an equilibration sample (blank run) with a 
method created to equilibrate the instrument

You can use a copy of the default method that comes with the 
system to equilibrate the instrument, or you can use the 
method created in the “Basic Exercise #1 Set up an 
equilibration method” on page 73.

For the tasks on the following pages, try the steps on the left 
without the detailed instructions. If you need more help, follow 
the detailed instructions on the right.

Before you start

Make sure that the pump is on standby and the VWD lamp is off.

Make sure that the methods for this exercise have been set up or 
restored. 
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Basic Exercise #1a Equilibrate the instrument
Task 1. Purge the pump from the Instrument Panel

Steps Detailed Instructions

1 Disengage pump and purge line B.

Flow rate: 5ml/min

%B = 100%

a Turn the black valve on the pump counterclockwise two full turns.
b Select Instrument from the Current View list.
c Select the instrument that you intend to equilibrate.

The Instrument Panel appears, along with the Online Plot.

d Click the pump module on the Instrument Panel.

A menu appears.

e Select Set Pump.
f Enter a Flow of 5ml/min and %B=100, and click OK.

2 Purge line A and engage pump.

%A = 100

a When there are no more bubbles in the line, repeat steps d and e from step 1.
b Set %B = 0, and click OK.
c When there are no more bubbles in the line, click the pump module, and 

select Standby.
d Tighten the black valve.
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Basic Exercise #1a Equilibrate the instrument
Task 2. Equilibrate the instrument from the Instrument Panel

Steps Detailed Instructions

1 Enter the pump parameters

Methanol as Solvent B:

• Flow rate: 2ml/min.
• Solvent composition: 

80%MeOH/20%H2O

Acetonitrile as Solvent B:

• Flow rate: 1.5ml/min
• Solvent composition: 

65%ACN/35%H2O

a Click the pump module on the Instrument Panel.
b Select Set Pump.

The Set Pump dialog box appears.

c Enter the pump parameters as shown in the left column, and click OK.

d Click the pump module, and select On.

2 Turn the detector lamp on a Click the detector module on the Instrument Panel.
b Select Lamp On.

Wait until baseline has stabilized.
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Basic Exercise #1a Equilibrate the instrument
3 Monitor the baseline until it appears 
stable.

After this step, you are ready to do the 
remaining exercises, or you can move 
on to the next task to learn to 
equilibrate the instrument with a 
method.

a Click Change at the bottom of the Online Plot.

The Edit Signal Plot dialog box appears.

b Select the detector signal you need from the Available Signals list, and click 
the Add button to put the signal in the Selected Signals list. (You can also 
select the pump pressure).

c Set the Predictable Range (Y-axis) as -10 to +10.
d Set the X-Axis range as 10 min.
e Click OK.

f Click the detector module after the lamp has been on for a few minutes.
g Select Balance.

When the baseline stays at zero for a few minutes after the balance, the 
baseline is considered stable.

Steps Detailed Instructions
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Basic Exercise #1a Equilibrate the instrument
Task 3. Equilibrate the instrument with a method—Enter an equilibration 
sample

Steps Detailed Instructions

1 Enter the sample information

Sample Name: equilsampiii, where iii 
are your initials

Method: defexer1 or equilmethiii

See “Before you start” on page 5 for 
instructions on how to restore and 
copy the default methods.

a Select Instrument from the Current View list.
b Expand the Sample Entry folder for the instrument that you need to 

equilibrate.
c Select Single Samples.
d Enter the Sample Name as equilsampiii.
e Select the Method as equilmethiii or defexer1.
f Select the Sample Type as Blank Run.
g Click Apply.

You can also enter the sample in the Sample View when you need to enter 
samples and sequences during a run.

2 Enter the tasks that the system will 
do during the analysis.

a Clear the Quantify and Report check boxes.
b Click Apply.

3 Save the sample to the database a On the Standard toolbar, click .
b Review the list of changes
c Under Reason for changes, enter a reason or select a reason from the list.
d Enter your electronic signature if required.
e Click the Save button.
Cerity NDS Getting Started Guide 15



Basic Exercise #1a Equilibrate the instrument
Task 4. Equilibrate the instrument with a method—Run the equilibration 
sample

Steps Detailed Instructions

1 Run equilsampiii a Select the sample, equilsampiii, in the Sample Table.

The Run button is now active.

b Click the Run button  on the Actions toolbar.

2 Monitor the baseline until it is 
stable.

a Select the instrument that you want to equilibrate.

The Instrument Panel appears, along with the Online Plot.

b Click Change at the bottom of the Online Plot.

The Edit Signal Plot dialog box appears. (See the figure on page 14.)

c Select the detector signal you need from the Available Signals list, and click 
the Add button to put the signal in the Selected Signals list.

d Set the Predictable Range as -10 to +10.
e Set the X-Axis range as 10 min.
f Click OK.
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Basic Exercise #2a
Run a single sample to produce an 
example chromatogram

This exercise contains a series of tasks to learn how to: 

• Enter a sample to produce an example chromatogram

• Run the sample

• Review the results

An example chromatogram can be any chromatogram that you 
produce. Use the example chromatogram to test new integration 
parameters and identify peaks as compounds. 

You can use one of the following methods for this exercise:

• A copy of the default method provided with the Cerity 
Networked Data System.

• The method saved in “Task 3. Save and audit method 
changes” on page 86 in the Setting Up Methods section.

• An equilibration method that you created in “Basic Exercise 
#1 Set up an equilibration method” on page 73.

For the tasks on the next pages, try the steps on the left without 
the detailed instructions. If you need more help, follow the 
detailed instructions on the right.

Before you start

Read “Running Routine Samples” on page 9 for running routing 
samples.

Equilibrate the instrument. See “Basic Exercise #1a Equilibrate 
the instrument” on page 11. Make sure that the methods for this 
exercise have been set up or restored.
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Basic Exercise #2a Run a single sample to produce an example chromatogram
Task 1. Enter a single sample

Steps Detailed Instructions

1 Start the Instrument View to find the 
sample table for single samples. 

a Select Instrument from the Current View list.
b Expand the folder for the instrument that will produce the example 

chromatogram.
c Select Single Samples.

The sample table and sample entry panel appear in the workspace.

2 Enter a sample with the following 
information:
• Name the sample exchromiii, 

where iii are your initials.
• Select either defexer2, exer2iii 

(when first saved), equilmethiii
• Select the vial that contains the 

full-strength isocratic standard.

a Enter exchromiii in the Sample Name box.
b Select a method from the Method list.

The instrument associated with the method appears in the Instrument box.

c Select Sample from the Sample Type list.
d Enter the vial number for the sample in the Vial Number box.
e Click Apply to put the sample information in the sample table.
Use the default values for all other parameters

3 Enter the tasks to perform during the 
run.

a Clear the Quantify and Report check boxes.

4 Save the sample. a On the Standard toolbar, click .

The Save Changes To The Database dialog box appears.

b Review the List of changes.
c Under Reason for changes, enter a reason or select a reason from the list.
d Enter your electronic signature if required.
e Click the Save button.
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Basic Exercise #2a Run a single sample to produce an example chromatogram
Task 2. Run the sample

Steps Detailed Instructions

1 Check that the instrument is ready 
for use.

a On the selection tree, select your instrument.
b Click the Online Plot tab.
c Click the Change button.

The Edit Signal Plot dialog box appears.

d Select the detector signal you need from the Available Signals list.
e Click the Add button to put the signal in the Selected Signals list.
f Select the Predictable Range option and set the predictable range from 

-20mAU to 300mAU.
g Under Window Properties, enter 5 min in the X-Axis range box.
h Click the OK button.
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Basic Exercise #2a Run a single sample to produce an example chromatogram
2 Run the sample. a On the selection tree, expand your instrument folder.
b Select Single Samples.
c Select the sample, exchromiii.

The Run button   becomes available on the Tools toolbar.

d Click the Run button.

You can also run the sample from the Sample View.

3 Monitor the signal, and track the 
status of the sample.

a On the selection tree, select your instrument.
b Click the Online Plot tab to view the signal. 

Change the axes if necessary.

c Click the Worklist tab to track the status of the sample.

After you click the Worklist tab, the Abort, Pause and Resume buttons 
become available.

Steps Detailed Instructions
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Basic Exercise #2a Run a single sample to produce an example chromatogram
Task 3. Review the chromatogram

Steps Detailed Instructions

1 Review the sample result and make 
sure all four peaks are integrated. 

a Select Result from the Current View list.
b Select MySamplesRunLast24h from the Query list.
c Expand the Samples folder.
d Expand the exchromiii folder.
e Select the exchromiii #1 injection.
f View the chromatogram and Summary results.

g Click the Integration tab to see the integration results.
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Basic Exercise #2a Run a single sample to produce an example chromatogram
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Basic Exercise #2b
Run a group of single samples to 
identify compounds

This exercise contains a series of tasks to learn how to: 

• Enter a sample 

• Run and track groups of single samples

• Review the results to check compound identification

You can use one of the following methods for this exercise:

• A copy of the default method provided with the Cerity 
Networked Data System (NDS).

• The method completed in “Basic Exercise #2 Set up a method 
for single samples to identify compounds” on page 81.

For the tasks on the following pages, try the steps on the left 
without the detailed instructions. If you need more help, follow 
the detailed instructions on the right.

Before you start 

Read “Running Routine Samples” on page 9.

Equilibrate the instrument. See “Basic Exercise #1a Equilibrate 
the instrument” on page 11.

Make sure that the methods for this exercise have been set up or 
restored.
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Basic Exercise #2b Run a group of single samples to identify compounds
Task 1. Enter three single samples

Steps Detailed Instructions

1 Start the Instrument View and find 
the sample table for single samples. 

a Select Instrument from the Current View list.
b Expand your instrument folder
c Select Single Samples.

The sample table and Sample Entry tab sheet appear in the workspace.

2 Enter a sample with the following 
information:
• Name the sample exer2biii1, where 

iii are your initials.
• Select the method for the sample:

defexer2 or exer2iii
• Select the Vial # that contains the 

the full-strength isocratic standard.

a Enter exer2biii1 in the Sample Name box.
b Select the exer2 method from the Method list (or copy of defexer2b).

The instrument associated with the method appears in Instrument box.

c Select Sample from the Sample Type list.
d Enter the Vial Number that contains the standard.
e Click Apply to put the sample information into the sample table.

3 Enter the tasks that you want the 
system to do during the run

a Mark the Quantify check box, and clear the Report check box.

You must mark the Quantify check box to identify the compounds, even 
though Calibration and Quantitation are not set up in the method.

b Click Apply.

4 Save the sample a On the Standard toolbar, click .

The Save Changes To The Database dialog box appears.

b Review the List of changes.
c Under Reason for changes, enter a reason or select a reason from the list.
d Click the Save button.
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Basic Exercise #2b Run a group of single samples to identify compounds
5 Repeat Steps 2 through 4 for the next 
two samples.

Name these samples, exer2biii2 and 
exer2biii3.

a Select the empty row.
b Start with Step 2a and finish with Step 4d for exer2biii2.
c Repeat steps a and b for exer2biii3.

Steps Detailed Instructions
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Basic Exercise #2b Run a group of single samples to identify compounds
Task 2. Run the samples

Steps Detailed Instructions

1 Check that the instrument is ready. a Select Instrument from the Current View list.
b Click the Online Plot tab.
c Click the Change button.

The Edit Signal Plot dialog box appears.

d Select the detector signal you need from the Available Signals list.
e Click the Add button to put the signal in the Selected Signals list.
f Select the Predictable Range option and set the range from -20mAU to 

300mAU.
g Under Window Properties, enter 15 min in the X-Axis range box.
h Click the OK button.
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Basic Exercise #2b Run a group of single samples to identify compounds
2 Run the samples. a Expand your instrument folder.
b Select Single Samples.
c Select the sample, exer2biii1.
d Click the Run button .
e Select the sample, exer2biii2. 
f Click the Run button.
g Select the sample, exer2biii3. 
h Click the Run button.

The samples run in the order started, unless exer2biii3 is of a higher priority 
than exer2biii2. Then, exer2biii3 runs before exer2biii2. The first sample 
started will always run first even if the sample is a lower priority than the 
other samples.

3 Monitor the signal, and track the 
status of the samples.

a Click the Online Plot tab to view the signal. 

Change the axes if necessary.

b Click the Worklist tab, and track the status of the three samples

Steps Detailed Instructions
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Basic Exercise #2b Run a group of single samples to identify compounds
Task 3. Review the chromatogram

Steps Detailed Instructions

1 Review the sample results and make 
sure all the compounds are 
identified in each sample. 

a Select Result from the Current View list.
b Expand the Calibration - exer2iii folder or defexer2 folder.

Even though calibration was not set up in the method, the result appears in a 
Calibration folder.

c Expand the Samples folder.
d Expand the exer2biii1 folder.
e Select the exer2biii1 #1 injection.
f View the result.
g Repeat steps d through f for the following samples:

• exer2biii2 
• exer2biii3.
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Basic Exercise #3a
Run a sequence to quantify compounds 
with single-level calibration

This exercise contains a series of tasks to help you learn to: 

• Create a sequence with a method set up for single-level, 
single-update calibration, ESTD quantification and fixed 
compound amounts

• Select report types and set up a directory for reports

• Run and track the sequence

• Review the results to make sure the compounds have been 
identified and quantified correctly

• Review the reports

You can choose between two methods to use with this exercise:

• a copy of the default method provided with the system.

• method that you created in “Basic Exercise #3 Set up a 
single-level calibrated method for a sequence” on page 91.

For the Basic exercises, try the steps on the left without the 
detailed instructions. If you need more help, follow the detailed 
instructions on the right.

Before You Start

Read “Running Routine Samples” on page 9.

Equilibrate the instrument. See “Basic Exercise #1a Equilibrate 
the instrument” on page 11.

Place all the vials of prepared samples into the ALS tray. Make 
sure that the methods for the exercise have been set up or 
restored.
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Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration
Task 1. Create a new sequence

Steps Detailed Instructions

Create a new sequence. 

Name the sequence exer3seqiii, 
where iii are your initials.

Use one of the two methods:

• defexer3
• exer3iii (created with Exercise 3 of 

Setting Up Methods)

a Click the New button, , in the Standard toolbar, and select Sequence.

The Create New Sequence dialog box appears.

b Enter the Sequence Name as exer3seqiii.
c Select the Instrument that will run the sequence.
d Select the Method for the sequence.
e Click OK.

f If the Save Changes to the Database dialog box appears, select the Reason 
for changes, if present, and click Save.
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Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration
Task 2. Enter sample and sequence information

Steps Detailed Instructions

1 Review the Sequence Table

Note how the sequence table 
matches the sequence template setup 
in the method.

a Select Instrument from the Current View list.
b Expand the instrument you are using, and select the sequence you just 

created.
c Review the table.

2 Enter the tasks to be performed 
during the run: 

Quantify, Report.

Acquire and Integrate are always 
marked.

a Click the Sequence Options tab.
b Make sure that the Quantify and Report check boxes are marked for the 

Task(s) to perform.
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Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration
3 Enter the destination path for, but do 
not print, the reports:

Enter Exercise3iii, where “iii” are your 
initials.

a Click the Report Destination tab.
b Clear the Printer check box, if necessary.
c Mark the Path check box, and enter the directory, Exercise3iii.

The system automatically creates this directory if it does not exist and places 
the generated reports into the directory Agilent\Cerity\Reports\Pharmaqc\
Reports

4 Select the following reports to be 
generated:

Single Injection

Standard Injection

Sequence

a Mark the Print check box to the left of the Report Types noted on the left 
margin.

b Clear all the Print check boxes that are not those noted on the left margin.

5 Save the sequence a Click , and enter reasons for changes and your password, if necessary.

Steps Detailed Instructions
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Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration
Task 3. Run and track the sequence

Steps Detailed Instructions

1 Make sure that the instrument is 
ready.

Use the same conditions as set in the 
method.

Online Plot settings:

• Y-Axis range: -20 to 300
• X-Axis range: 15 minutes

a Select the instrument for the sequence from the selection tree.
b Make sure the instrument and column are equilibrated, and the conditions 

are the same as those set in the method for the sequence.

c Click Change at the bottom of the Online Plot.

The Edit Signal Plot dialog box appears.

d Select the detector signal you need from the Available Signals list, and click 
Add to place this signal on the right.

e Set the Predictable Range as -20 to 300.
f Set the X-Axis range as 15 min.
g Click OK.
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Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration
2 Run the sequence. a Expand the instrument folder.
b Select the sequence that you just set up.

The Run button, , appears.

c Click the Run button.

3 Monitor the signal, and track the 
status of the sequence.

a Select the instrument.
b Observe the signal in the Online Plot tab, and change the axes if you need to.

c Click the Worklist tab, and observe the status of the sequence.

Note that the Abort, Pause and Resume buttons appear when you enter the 
Worklist.

Steps Detailed Instructions
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Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration
Task 4. Review the results and reports

Steps Detailed Instructions

1 Review the calibration table and 
curve for each revision of the 
calibration. 

a Select Result from the Current View.
b Select AllSeqNotApprovedRunLast7Days from the Query list.
c Expand the exer3seqiii folder.
d Select the Calibration - exer3seqiii Calib Rev 2 folder.

The calibration table and curve appear in the workspace.

e Select the Calibration - exer3seqiii Calib Rev 3 folder.
f Select the Calibration - exer3seqiii Calib Rev 4 folder.
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2 Review the results for each 
calibration standard in each 
revision.

Note the different response factors 
used to quantify the samples.

a Expand the Calibration - exer3seqiii Calib Rev 2 folder.
b Expand the Calibrations folder.
c Expand the Cal1 folder.
d Select Cal1 #1.
e Observe the response factor in the workspace.

f Expand the Calibration - exer3seqiii Calib Rev 3 folder.
g Repeat steps b-c.
h Select the second Cal1 standard.
i Observe the response factor.
j Expand the Calibration - exer3seqiii Calib Rev 4 folder.
k Repeat steps b-c.
l Select the third Cal1 standard.
m Observe the response factor.

Steps Detailed Instructions
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Basic Exercise #3a Run a sequence to quantify compounds with single-level calibration
3 Review the sample results for each 
revision.

Note the response factor used for the 
quantitation.

a Expand the Calibration - exer3seqiii Calib Rev 2 folder.
b Expand the Samples folder.
c Expand the Sample1_2 folder.
d Select Sample1_2 #1.
e Observe the response factor in the workspace.
f Repeat steps c-e for Sample1_4.

g Expand the Calibration - exer3seqiii Calib Rev 3 folder.
h Repeat steps b-f.
i Expand the Calibration - exer3seqiii Calib Rev 4 folder.
j Repeat steps b-f.

4 Review the reports.

Hint: Use the Report Viewer to open 
the reports.

a Select Start > Programs > Agilent Cerity > Report Viewer.
b Select File > Open.
c Open Cerity > Agilent > Reports > PharmaQC > Reports > Exercise3iii.
d Open and view each report.

Steps Detailed Instructions
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Basic Exercise #3b
Reintegrate and reprocess the results

This exercise contains a series of tasks to help you learn to: 

• Manually reintegrate the calibration standard results

• Change sample variable values

• Reprocess the sequence with the original method revision

You use the data produced in Exercise #3a.

For the tasks on the following pages, try the steps on the left 
without the detailed instructions. If you need more help, follow 
the detailed instructions on the right.

Before you start

Read “Running Routine Samples” on page 9.
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Basic Exercise #3b Reintegrate and reprocess the results
Task 1. Make changes to the results and sample information

Steps Detailed Instructions

1 Find the single injection result for 
the third quantitation of sample1_4 
in the sequence exer3seqiii.

a Select Result from the Current View.
b From the Query List, select MySeqNotApprovedRunLast7days.
c Expand the exer3seqiii folder.
d Expand the Calibration - exer3iii Calib Rev 4 folder.
e Expand the Samples folder.
f Expand the sample 1_4 folder.
g Select sample 1_4#1.
h Click the Integration tab.
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Basic Exercise #3b Reintegrate and reprocess the results
2 Manually reintegrate the 
dimethylphthalate peak.

Draw the baseline from the bottom 
left corner of the peak to the 
inflection point on the bottom right of 
the peak.

Note that the Amount and RF values 
disappear.

a On the Integration toolbar, click .

A mouse pointer in the shape of a bell curve appears on the chromatogram. 

b Place the pointer at the bottom left of the peak at the intersection between 
the baseline and peak, and click once.

c Hold the mouse button down, and move the pointer to the inflection point at 
the bottom right of the peak.

d Release the mouse button.

The new baseline appears, but the bell curve pointer remains.

e On the Integration toolbar, click  to change the pointer from a bell curve 
pointer to a normal pointer.

Steps Detailed Instructions
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3 Change sample variable values.
• Dilution = 5
• Purity = .9

a Select the sequence, exer3seqiii.

The sequence table and Sample Entry panel appear in the workspace.

b Select the first sample 1_4 in the sequence.
c Click the Amounts tab, and enter a default value for the Dilution factor of 5.
d Enter a default value for the Purity of .9, and click Apply.
e Repeat steps c and d for every sample 1_4 in the sequence.

Steps Detailed Instructions
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Basic Exercise #3b Reintegrate and reprocess the results
Task 2. Reprocess the sequence results

Steps Detailed Instructions

1 Open the Reprocess window.

See Chapter 3, “Sample Analysis”, in 
the Concepts Guide for a chart that 
helps you select the correct 
reprocessing option.

a Select the sequence, exer3seqiii.

The Save Reasons for Changes dialog box appears.

b Enter any information requested, and click Save.
c Select Actions > Reprocess in the top menu bar.

2 Select the reprocessing option that 
uses all other method settings of the 
original method, except for the 
integration settings and default 
sample variable values.

In the Cerity system all sample, 
sequence, method and instrument 
information is attached to the result.

a Select Use the method revision now attached to the result.
b Click OK.
The Cerity system uses the settings of the method originally used to run the 
sequence, the new manual integration setting and the new sample variable 
values to process the sequence.
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3 Track reprocessing until complete. a Select the sequence, exer3seqiii.
b Click the Sequence Options tab. 

When the system has completed reprocessing, the message “Completed 
Reprocessing“ appears on the Sequence Options panel
.

Steps Detailed Instructions
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Advanced Exercise #4a
Run a sequence to quantify compounds 
with multi-level calibration

This exercise contains a series of tasks to help you learn how to: 

• Create a sequence with a method set up for multi-level, 
overall calibration, ESTD quantitation and variable 
compound amounts

• Enter new information for an individual sample or standard

• Edit a sequence during a run

• Review the results to view the multi-level, overall calibration 
process.

• View the early quantitation single injection reports and the 
sequence report

You can choose between two methods to use with this exercise:

• A copy of defexer4iii, the instrument method copied from 
the default method provided with the system.

• Exer4iii, the method that you created in “Advanced Exercise 
#5 Set up a multi-level calibrated method for a sequence” on 
page 121.

For tasks on the following pages, try the steps on the left 
without the detailed instructions. If you need more help, follow 
the detailed instructions on the right.

Before you start

Read “Running Routine Samples” on page 9.

Equilibrate the instrument. See “Basic Exercise #1a Equilibrate 
the instrument” on page 11.
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Advanced Exercise #4a Run a sequence to quantify compounds with multi-level calibration
Task 1. Create a new sequence, and enter sample and sequence 
information

Steps Detailed Instructions

1 Create a new sequence. 

Name the sequence exer4seqiii, 
where iii are your initials.

Use one of the two methods:

• defexer4iii
• exer4iii (created with Exercise 4 of 

Setting Up Methods)

• For detailed instructions, see “Task 1. Create a new sequence” on page 30.

After you create a new sequence, the revision number is set to 1.

2 Enter values for sample amounts and 
variables.

For the first sample 1_2, enter:

• Sample Amount - 2.5 mg
• Dilution Factor - 2
• Purity - .93

a Select Instrument from the Current View list.
b Expand the instrument folder.
c Select exer4seqiii.
d Select the first sample 1_2 in the Sequence Table.
e Click the Amounts tab.
f Enter 2.5 for the Sample Amount.
g Change the Dilution Factor value to 2.
h Change the Purity value to .93.

3 Enter compound amounts.

To quantify a compound in a sample, 
you must select to use the compound 
amount for the standard.

For the second set of calibration 
standards for dimethyl phthalate, 
enter compound amounts:

• Cal1 - 10.17 µg
• Cal2 - 37.62 µg

a Click the Sequence Table tab, and select Cal1 from the second set of 
standards.

b Enter 10.17 for the Compound amount.
c Select Cal2 from the second set of standards.
d Enter 37.62 for the Compound amount.
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Advanced Exercise #4a Run a sequence to quantify compounds with multi-level calibration
4 Enter the tasks to be performed 
during the run: 

Quantify, Report, Allow Online Editing

a Select the sequence that you just created.
b Click the Sequence Options tab.
c Make sure that the Quantify and Report check boxes are marked for the 

Task(s) to perform.
d Mark the Allow Online Editing check box.

5 Enter the destination path for, but do 
not print, the reports:

Enter Exercise4iii, where iii are your 
initials.

• For the detailed instructions, see step 3 on page 32.

6 Save the sequence • On the Standard toolbar, click , and enter reasons for changes and your 
password, if necessary.

After you save the sequence, the revision increments by one. Here, the 
revision number is set to 2.

Steps Detailed Instructions
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Advanced Exercise #4a Run a sequence to quantify compounds with multi-level calibration
Task 2. Edit the sequence during the run

Steps Detailed Instructions

1 Run the sequence after the 
instrument is ready.

For detailed instructions, see “Task 3. Run and track the sequence” on page 33, 
Steps 1 and 2.

Note that the sequence disappears from beneath the instrument folder.

After you run the sequence, the revision number increments by one. Here, the 
revision number is set to 3.

2 Edit the sequence during the run:

After the last peak comes off during 
the run of the first standard, select to 
immediately quantify the first sample 
1_4 in the sequence.

a On the selection tree, select the instrument.
b On the instrument workspace, click the Worklist tab.
c Select the sequence.
d After the last peak comes off during the run of the first standard, click , 

in the toolbar.

The sequence in the worklist now says “Preparing to edit”. When the sample 
run is complete, the sequence is stopped and the status says “Editable”.

e Expand the instrument folder. (Note that the sequence has reappeared.)
If you do not see the sequence, click the Redo Query button or F5.

f Select the sequence, and select the first sample 1_4 in the Sequence Table.
g Double-click the Immediate Quantitation cell.
h Double-click Yes.
i Save and run the sequence.

The revision number increments to 4 after you save the sequence.
The revision number increments to 5 after you run the sequence.

j Select the instrument and click the Worklist tab. (The sequence starts with 
the second standard.)
48 Cerity NDS Getting Started Guide



Advanced Exercise #4a Run a sequence to quantify compounds with multi-level calibration
Task 3. Review the calibration results

Steps Detailed Instructions

1 Review the calibration table and 
curve. 

If you ran the sample more than 7 
days ago, you must modify the query 
to retrieve older results from the 
database. See the online How To help, 
“Define a query.”

Note that when you first view the 
sequence result in the Result View, 
the revision number equals the 
number of saves that you made plus 
the number of run executions. In this 
exercise, the revision number for the 
sequence result is 5.

See Chapter 5, ”Sample Analysis”, in 
the Concepts Guide for information on 
sequence and calibration revisioning.

a Select Result from the Current View.
b Select AllSeqNotApprovedRunLast7Days from the Query list.
c Expand the exer4seqiii folder.

One folder appears that contains the calibration and single injection results.

d Select any one of the Calibration - exer4seqiii Calib Rev 5 folder.

The calibration table and curve appear in the workspace.

e View how the system uses the standards in overall calibration to quantify the 
samples compared to single-level calibration in Exercise 3a.
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Advanced Exercise #4a Run a sequence to quantify compounds with multi-level calibration
2 Review the single injection results 
for both sample 1_2 injections.

Note that the Amount is different for 
the first sample 1_2. Why?

The Amount is the compound amount 
in the sample. The value for this 
exercise represents the compound 
amount in the injection times the 
values of the dilution factor and 
purity. When you entered this sample, 
you changed these values.

a Expand any one of the Calibration folders.
b Expand the Samples folder.
c Expand the first sample 1_2 folder.
d Select the single injection.
e Note the value in the Amount column.

f Expand the second sample 1_2 folder.
g Select the single injection.
h Compare the Amounts from the first and second sample1_2’s.

Steps Detailed Instructions
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Advanced Exercise #4a Run a sequence to quantify compounds with multi-level calibration
Task 4. Review the reports

Steps Detailed Instructions

1 Review the two single injection 
reports for the first sample 1_2 and 
sample 1_4.

Note that there is only one folder for 
each of the second set of samples 
because they were not marked for 
Immediate Quantitation.

a Select Start > Programs > Agilent Cerity > Report Viewer.
b Select File > Open, or click the Open button.
c Expand the Exercise4iii folder.
d Expand the 003 Multi-Injection Summary Group folder, and expand the 01 

Sample single injection folder.
e Double-click default.htm.

Note the compound amounts.

f Expand the 003 Multi-Injection Summary Group 0001 folder, and expand the 
01 Sample single injection folder.

g Double-click default.htm.

Note the compound amounts.

h Repeat steps d-g for the 004 Multi-Injection Summary Group folders.

2 View the sample amount for the first 
sample 1_2 in the Sequence Report.

a Click the Open button, and expand the Exercise4iii folder.
b Expand the Sequence folder, and double-click default.htm.
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Advanced Exercise #4b
Change sample variables in the method 
and reprocess

This exercise contains a series of tasks to help you learn to: 

• Change an integration setting in the method.

• Remove a calibration point.

• Change the sequence so that no sample is immediately 
quantified after processing

• Reprocess the sequence with the most current method 
revision.

• Add a new sample variable to the method.

• Reprocess the sequence after you add the new variable

• Regenerate the reports

You use the data produced in Exercise #4a.

For the tasks on the following pages, try the steps on the left 
without the detailed instructions. If you need more help, follow 
the detailed instructions on the right.

Before you start

Read “Running Routine Samples” on page 9.
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Advanced Exercise #4b Change sample variables in the method and reprocess
Task 1. Update the method and result

Steps Detailed Instructions

1 Change the integration setting in the 
method.

Set the Height Reject to 0.

If you are using a copy of the 
defexer4iii method, make sure that no 
one else has modified it. Check the 
old revisions. If it has been modified, 
make another copy of the default 
method. See “Before you start” on 
page 5.

a Select Method from the Current View.
b Expand the exer4iii folder.
c Expand the Data Analysis folder.
d Select Integration.
e Click the Height Reject cell, and enter 0.
f Save the method.

2 Remove the second Cal2 calibration 
point for dimethylphthalate.

a Select Result from the Current View.
b Expand the exer4seqiii folder.
c Select the Calibration - Exer4iii folder.
d Click the Calibration cell for the second Cal2 calibration.
e Click the .. button, and double-click the cell to change Yes to No.
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Advanced Exercise #4b Change sample variables in the method and reprocess
3 Change the sequence so that no 
sample is immediately quantified 
during processing

a Select the exer4seqiii sequence.
b In the sequence table, double-click the Immediate Quantitation cell for the 

first Sample1_2.
c Double-click No.
d Repeat steps b and c for the first Sample1_4.
e Save the changed result.
Note that the revision is incremented by 1.

Steps Detailed Instructions
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Advanced Exercise #4b Change sample variables in the method and reprocess
Task 2. Reprocess and review the result

Steps Detailed Instructions

1 Reprocess the sequence with the 
most current revision of the method.
• Use the integration settings in the 

method.
• Set up to print (regenerate) reports

a Select the exer4seqiii sequence.
b Select Actions > Reprocess.
c Select Use the most current revision of the method that is attached to the 

result.
d Mark the Use integration settings in the method check box.
e Mark the Print Reports check box.
f Click OK.
g To follow reprocessing, click the Sequence Options tab.

2 Make sure the integration change 
appears in the reprocessed result.

If you cannot see the calibration 
standard chromatogram because of 
the example chromatogram, click the 
Layout button and clear the Display 
Example Chromatogram check box.

a Expand the second Calibration - Exer4iii folder.
b Expand the Calibrations folder and the Cal1 folder.
c Select Cal1 #1.

Note that one or more peaks are now integrated and appear in the Results 
Table.
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Advanced Exercise #4b Change sample variables in the method and reprocess
3 Review the calibration summary. • Select the second Calibration - Exer4iii folder.

Note that the calibration point that you removed before reprocessing is gone.

4 Review the reports for the first set of 
samples to make sure that they were 
quantified with all the calibration 
standards.

a Select Start > Programs > Agilent Cerity > Report Viewer.
b Select File > Open.
c Expand Exercise4iii-0001.

Note that only one report exists for all the samples. After initial processing 
two reports existed for the first Sample1_2 and Sample1_4.

Steps Detailed Instructions
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Advanced Exercise #4b Change sample variables in the method and reprocess
Task 3. Add a new sample variable to the method and reprocess

Steps Detailed Instructions

1 Add a new variable to the method.

Add a divisor called “attenuation 
factor” with a default value of 3.

a Select Method from the Current View list.
b Expand the current revision of exer4iii.
c Select Sample Variables.
d Type “attenuation factor” into a Divider cell of the System Sample Variables 

table.
e Enter a Default Value of 3.
f Save the method.

2 Reprocess the sequence with the 
revised method.
• Enter a new value for the 

Attenuation Factor of 7 for the first 
Sample 1_2.

• Set up to print (regenerate) reports.

a Select Result from the Current View list.
b Select exer4seqiii.
c Select Actions > Set up reprocessing for new sample entry fields.

d Click OK.

The new Sample Entry panel appears.

e Click the Amounts tab, and enter 7 for the “Attenuation Factor”.
f Select Actions > Reprocess.
g Select Use the method revision now attached to the result.
h Mark the Print Reports check box.
i Click OK.
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Advanced Exercise #4b Change sample variables in the method and reprocess
3 Find the report for the first 
Sample1_2.

Note that the quantitation value is 
different after reprocessing. The 
software used the “Attenuation 
Factor” in the calculation.

a Select Start > Programs > Agilent Cerity > Report Viewer.
b Select File > Open.
c Expand Exercise4iii-0002.
d Expand the 003Multi-Injection Summary folder.
e Expand the 01Sample Single Injection folder.
f Double-click Default.htm.

The report appears with the new amount for Sample1_2.

Steps Detailed Instructions
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Advanced Exercise #5a
Run a sequence to quantify impurities

This exercise contains a series of tasks to help you learn to 
review results and reports of a sequence run with a method set 
up for multi-level, bracketed calibration, ISTD quantitation and 
variable compound amounts. You learn how to:

• Recognize the results of an overall calibration

• Find the system suitability calculations that were selected for 
the review layout in the method

• Find the custom calculations that were set up in the method

• Review the reports for the calculations that were set up in 
the report template

You can choose between two methods to use with this exercise:

• instrument method copied from the default method provided 
with the system, defexer5.

• method that was created in “Advanced Exercise #6 Set up a 
method for a sequence to quantify impurities” on page 133.

For the tasks on the following pages, try the steps on the left 
without the detailed instructions. If you need more help, follow 
the detailed instructions on the right.

Before you start

Read “Running Routine Samples” on page 9.

Equilibrate the instrument. See “Basic Exercise #1a Equilibrate 
the instrument” on page 11.
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Advanced Exercise #5a Run a sequence to quantify impurities
Task 1. Set up and run the sequence

Steps Detailed Instructions

1 Create a new sequence. 

Name the sequence exer5seqiii, 
where iii are your initials.

Use one of the two methods:

• defexer5
• exer5iii (created with Exercise 5 of 

Setting Up Methods)

• For detailed instructions, see “Task 1. Create a new sequence” on page 30.

2 Make sure that Quantify and Report 
are selected.

• For detailed instructions, see “Task 2. Enter sample and sequence 
information” on page 31, Step 2.

3 Enter the destination path for, but do 
not print, the reports, and save the 
sequence.

Enter Exercise5iii, where “iii” are your 
initials.

• For detailed instructions, see “Task 2. Enter sample and sequence 
information” on page 31, Step 3.

4 Run and track the sequence. • For detailed instructions, see “Task 3. Run and track the sequence” on 
page 33.
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Advanced Exercise #5a Run a sequence to quantify impurities
Task 2. Review the results and reports

Steps Detailed Instructions

1 Compare the response factors for 
dimethylphthalate for the first set of 
bracketed samples with the second 
set. 

Hint: If you can’t see the RFs, click the 
bottom of the Compound Summary 
panel to make the scroll bar appear.

Note that the RFs for the second Cal1 
and Cal2 for the first set of bracketed 
samples are the same as for the first 
Cal1 and Cal2 for the second set of 
bracketed samples.

a Select Result from the Current View.
b Select AllSeqNotApprovedRunLast7Days from the Query list.
c Expand the exer3seqiii folder.
d Select the second Calibration - exer3seqiii folder.

The first calibration folder contains the blank run.
e Scroll to see the RFs if not visible.
f Select the third Calibration - exer5seqiii folder.
g Scroll to see the RFs if not visible.
h Compare the RFs.

2 Review the system suitability 
calculations for Cal1 #1 under the 
second calibration folder.

Note the values for the Average 
Percent Specified Impurity and the 
Average Percent Unspecified Impurity 
calculations that were set up as 
custom calculations in the method.

a Expand the second Calibration - exer3seqiii Calib folder.
b Expand the Calibrations folder.
c Expand the Cal1 folder.
d Select Cal1 #1.
e Review the Results Table for the system suitability calculations.

You may have to click the bottom of the Results table to see the scroll bar.
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Advanced Exercise #5a Run a sequence to quantify impurities
3 Review the percent impurity results 
for the first Sample1_2 and for the 
sample group.

Note that the percent impurity values 
exceeded their limits.

a Expand the second Calibration - exer3seqiii folder.
b Expand the Samples folder.
c Select the Sample1_2 folder.

Note that the average percent specified and unspecified impurities for both 
injections appear here.

d Expand the Group Results folder.
e Select Samples.

The results for the average of the percent impurities over all samples appear 
here, as do the results of the limit checks for these impurities.

Steps Detailed Instructions
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Advanced Exercise #5a Run a sequence to quantify impurities
4 Review the sample single injection 
report for the first Sample1_2 and 
the report for the sample group.

a Select Start > Programs > Agilent Cerity > Report Viewer.
b Select File > Open.
c Expand Exercise5iii.
d Expand 003Multi-InjectionSummary.
e Expand 01Sample Single Injection, and double-click default.htm.

Note the system suitability calculation values in the table that was set up in 
the method.

f Expand Exercise5iii.
g Expand Sample Group, and click default.htm.

Note the percent impurity calculations and limits that were set up in custom 
calculations and the report template in the method.

Steps Detailed Instructions
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Advanced Exercise #5b
Use a different method to reprocess

This exercise contains a series of tasks to help you learn to: 

• set up a different method with a new calibrated compound

• set up reprocessing for a different method

• reprocess the sequence with the different method

You use the data produced in Exercise #5a.

For the tasks on the following pages, try the steps on the left 
without the detailed instructions. If you need more help, follow 
the detailed instructions on the right.

Before You Start

Read “Running Routine Samples” on page 9.
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Advanced Exercise #5b Use a different method to reprocess
Task 1. Set up a different method

Steps Detailed Instructions

1 Copy exer5iii and rename it 
exer5iii2.
• Or, copy defexer5.
• Or, use defexer5iii2 to reprocess.

a Select File > New > Method.
b Click the Browse button in the Method Wizard.
c Select exer5iii.
d Enter a New Method Name of exer5iii2, and click Next.
e Click Next until you reach the New Method Review panel.
f Click Finish and click Save.

2 Add diethylphthalate as a calibrated 
compound.
• Cal Level 1 - 8 µg
• Cal Level 2 - 32 µg
• Set biphenyl as the ISTD for this 

compound.

a Expand the exer5iii2 folder.
b Expand the Data Analysis folder.
c Select Calibration.
d Right-click the calibration table, and select Insert Compound.
e Select diethylphthalate, click > and click OK.
f In the calibration table, select diethylphthalate.
g Click on the Level 1 Use Default Amount cell, and click the .. button.
h Select the + sign, and enter 8 µg into the Weighed Amount and Unit cells.
i Repeat steps g and h for Level 2 and 32 µg.
j Select Quantitation.
k Select diethylphthalate.
l Mark the Use ISTD Compound check box, and select biphenyl.
m Save the method.
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Advanced Exercise #5b Use a different method to reprocess
Task 2. Reprocess the sequence result

Steps Detailed Instructions

1 Set up reprocessing for a different 
method.

Select exer5iii2 or defexer5iii2.

See Chapter 3, “Sample Analysis”, in 
the Concepts Guide for a chart that 
helps you select the correct 
reprocessing options.

a Select Result from the Current View.
b From the Query List, select MySeqNotApprovedRunLast7days.
c Select the exer5seqiii folder.
d Select Actions > Set up reprocessing for a different method.

e Click Browse, select exer5iii2 and click OK.
f Click OK, and click Save.

A copy of the sequence appears in the selection tree, ready for reprocessing. 
This copy is now attached to the new method but has no folders underneath 
until it is reprocessed.

2 Enter amounts for the new calibrated 
compound, diethylphthalate, for 
every calibration standard.

Level 1- 8

Level 2 - 32

a Select this copy (note the date and time after it).
b Click the Amount tab on the Sample Entry panel in the sequence workspace.
c For each Level 1 standard, mark the Use checkbox for diethylphthalate, and 

enter 8.
d For each Level 2 standard, mark the Use checkbox for diethylphthalate, and 

enter 32.
e Save the result.
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Advanced Exercise #5b Use a different method to reprocess
3 Reprocess the copy. a Select Actions > Reprocess
b Make sure that Use the method revision now attached to the result is 

marked.
c Click OK. 
d Monitor the reprocessing from the Sequence Options panel.
e Click the Redo Query button.
f Expand the copy.
g Select a calibration folder.
h Make sure that diethylphthalate is now included as a calibrated compound.

Steps Detailed Instructions
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Setting Up Methods

These exercises help you learn how to set up methods for your 
laboratory. See Chapter 4, “Method Setup”, in the Concepts 
Guide for background information that can help you use these 
exercises. The set of basic and advanced exercises includes the 
following topics:

Basic Exercise 1 – Set up an equilibration method Learn how to set up 
a method template and enter instrument parameters to 
equilibrate the instrument.

Exercise 2 – Set up a method for single samples to identify 
compounds Learn how to use an example chromatogram to set 
up integration and compound identification for single samples.

Exercise 3 – Set up a single-level calibrated method for a sequence
Learn how to set up single-level, single-update calibration, 
ESTD quantitation, and fixed compound amounts.

Advanced Exercise 4 – Set up a multi-level calibrated method for a sequence
Learn how to set up multi-level, overall calibration, ESTD 
quantitation, variable compound amounts, and sample 
variables.

Exercise 5 – Set up a method for a sequence to quantify impurities
Learn how to setup ISTD quantitation, custom calculations, 
limits, bracketed calibration, and system suitability.

After you set up the methods in Exercises 1-5, you can use them 
to run the samples and sequences in Exercises 1-5 of the 
section—“Running Routine Samples”.
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Before you start Read “Before you start” on page 5!

Your system administrator must have configured an Agilent 
1100 LC series liquid chromatograph for your system. 

If you plan to copy a default method to create a new method as 
in Exercises 3 and 5, make sure that the default methods are in 
your database. From the Query list, select AllMethodsRestored 
to view defexer1-5. If they do not appear, see the instructions in 
“Before you start” to transfer these methods from the CD-ROM 
to your database.
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Basic Exercise #1
Set up an equilibration method

This exercise provides a series of tasks to learn how to: 

• Create a method template to set up instrument parameters

• Set up instrument parameters

• Save and audit method changes

• View the history of method changes

A method template is a framework to let you enter only those 
conditions and parameters that you need to acquire and 
process data. A method is a method template that contains 
entered parameter values.

Use this method to equilibrate the instrument as outlined in the 
chapter “Basic Exercise #1a Equilibrate the instrument” on 
page 11.

For the tasks on the following pages, try the steps on the left 
without the detailed instructions. If you need more help, follow 
the detailed instructions on the right.

Before you start

Read “Setting Up Methods” on page 71 for setting up methods.
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Basic Exercise #1 Set up an equilibration method
Task 1. Create a method template to enter instrument parameters

Steps Detailed Instructions

1 Create a new method template for a 
single sample.
• Name the method template, 

equilmethiii, where iii are your 
initials.

a Select File > New > Method or click  and select Method.
The Method Wizard appears.

b On the New Method panel, enter the Method Name, equilmethiii.
c Select Single Sample.

d Click Next to scroll to the Instrument panel.
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Basic Exercise #1 Set up an equilibration method
2 Select the instrument to equilibrate. a On the Instrument panel, select the instrument you need to equilibrate.
The instruments that appear in the Available Instruments list depends on 
your configuration of the Cerity Networked Data System.

b Click Next to scroll to the Data Analysis panel.

3 Clear all data analysis selections. a On the Data Analysis panel, clear the Compound Identification check box.

b Click Next to scroll to the New Method Review panel.

Steps Detailed Instructions
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Basic Exercise #1 Set up an equilibration method
4 Review and save the method 
template.

a On the New Method Review panel, review the setting in the Method Wizard 
Settings section.

b Add the words “Test Comment” in the Comment section.
c Click Finish.

d Click Save if the Save Changes to the Database dialog box appears.

5 View the Method Wizard settings in 
the method.

After you save the method template, the Method View appears.
a Select the method you just created - equilmethiii.
b View the Method Description in the workspace.

Notice that the Method Description corresponds to the Comment section of 
the New Method Review panel in the Method Wizard.

Steps Detailed Instructions
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Basic Exercise #1 Set up an equilibration method
Task 2. Enter the instrument conditions for the equilibration

Steps Detailed Instructions

1 Set the pump parameters:

Methanol as Solvent B:

• Flow rate: 2ml/min.
• Solvent composition: 

80%MeOH/20%H2O
• Stoptime: 10 min.

Acetonitrile as Solvent B:

• Flow rate: 1.5ml/min
• Solvent composition: 

65%ACN/35%H2O
• Stoptime: 10 min.

a On the selection tree, expand the equilmethiii method folder.
b Expand the Instrument Setup folder and select Quaternary Pump or Binary 

Pump.
c Enter the Flow as 2 ml/min.
d Under Solvents, mark the B check box and enter 80 in the % box.

The percent of solvent A is automatically set to 20 %.
e Under Stoptime, select the min option and enter 10.
f Under Posttime and Pressure Limits, accept the default values.

2 Set the autosampler (ALS) injection 
volume to zero

a Select the ALS folder.
b Click the Setup tab.
c Under Injection, select Standard Injection, 
d Set the Injection Volume to zero.
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Basic Exercise #1 Set up an equilibration method
3 Set the same stoptime for all 
modules.

Stoptime: 10 min.

a Select the ALS folder, 
b Click the Auxiliary & Time tab.
c Under Stoptime, select the as Pump option.
d Select the DAD, MWD, or VWD folder that appears in your detector 

configuration.
e Under Stoptime, select the as Pump/Injector option.
f Select the TCC folder.
g Under Stoptime, select the as Pump/Injector option.
h Accept default values for all other module parameters 

Steps Detailed Instructions
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Basic Exercise #1 Set up an equilibration method
Task 3. Save and audit method changes

Steps Detailed Instructions

1 Save the method. 

The Cerity administrator must set up 
auditing for the Save Changes To The 
Database dialog box to appear. The 
Cerity administrator can provide a list 
of reasons and require you to enter 
your electronic signature to complete 
the dialog box. These requirements 
can only appear when a Cerity GMP 
license is installed and Auditing is set 
up by the Cerity administrator.

a On the Standard toolbar, click .

The Save Changes To The Database dialog box appears.

b Review the List of changes.
c Under Reason for changes, enter a reason or select a reason from the list.
d Click the Save button.

2 View the history of changes to the 
method.

If you need to use this method before 
you set up other methods, use the 
method with Running Routine 
Samples, Basic Exercise #1, 
Equilibrate the instrument.

a On the selection tree, select the method, equilmethiii.
b View the list of changes to the method.

Individual setpoint changes can only appear in the history of changes when a 
Cerity GMP license is installed and Auditing is set up by the Cerity administrator.
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Basic Exercise #1 Set up an equilibration method
80 Cerity NDS Getting Started Guide



Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Basic Exercise #2
Set up a method for single samples to 
identify compounds

This exercise contains a series of tasks to learn how to: 

• Create a method template for single samples to include only 
compound identification in the method

• Set up and save the method to produce an example 
chromatogram

• Use an example chromatogram to set up integration

• Set up compound identification

A method template is a framework to let you enter only 
conditions and parameters that you need to acquire and 
process data. 

Use the method created in the first part of this exercise to enter 
and run a single sample to produce an example chromatogram. 
You can use the completed method to enter and run a group of 
samples to identify compounds. See “Basic Exercise #2a Run a 
single sample to produce an example chromatogram” on 
page 17 and “Basic Exercise #3b Reintegrate and reprocess the 
results” on page 39.

For the tasks on the following pages, try the steps on the left 
without the detailed instructions. If you need more help, follow 
the detailed instructions on the right.

Before you start

Read “Setting Up Methods” on page 71 for setting up methods.
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Basic Exercise #2 Set up a method for single samples to identify compounds
Task 1. Create a method template to identify compounds only

Steps Detailed Instructions

1 Create a new method template for a 
single sample.
• Name the method template, 

exer2iii, where iii are your initials.

c Select File > New > Method or click  and select Method.

The Method Wizard appears.

d Enter exer2iii in the Method Name box.
e Select Single Sample.

f Click Next to scroll to the Method Wizard Instrument panel.

2 Select an instrument for the method. a On the Instrument panel, select the instrument that will run the sample.

b Click Next to scroll to the Data Analysis panel.
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Basic Exercise #2 Set up a method for single samples to identify compounds
3 Mark only Compound Identification. a On the Data Analysis panel, Clear the Calibration and Quantification, Include 
Noise Calculations and Include System Suitability Calculations check 
boxes.

b Click Next to scroll to the Identification panel.

4 Complete the setup of the method 
template.

Do not mark any check box on the 
Method Wizard Identification panel.

a Click Next, and click the Finish button.
b Click Save if the Save Changes to the Database dialog box appears.

Steps Detailed Instructions
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Basic Exercise #2 Set up a method for single samples to identify compounds
Task 2. Enter the instrument conditions for the equilibrium

Steps Detailed Instructions

1 Enter the pump parameters:

Methanol as Solvent B:

• Flow rate: 2ml/min.
• Solvent composition: 

80%MeOH/20%H2O
• Stoptime: 5 min.

Acetonitrile as Solvent B:

• Flow rate: 1.5ml/min
• Solvent composition: 

65%ACN/35%H2O
• Stoptime: 6 min.

a On the selection tree, expand the exer2iii method folder.
b Expand the Instrument Setup folder and select the Quaternary Pump or 

Binary Pump.
c Enter the Flow as 2 ml/min.
d Under Solvents, mark the B check box and enter 80 in the % box.

The percent of solvent A is automatically set to 20 %.
e Under Stoptime, select the min option and enter 5.

2 Enter the injection volume and stop 
time for the autosampler.

Injection Volume: 1µl

Stop Time: same as pump

a On the selection tree, select the ALS folder.
b Click the Auxiliary & Time tab.
c Under Stoptime, select the as Pump option.
d Click the Setup tab and select Standard Injection.
e Enter 1µl for the Injection Volume.
84 Cerity NDS Getting Started Guide



Basic Exercise #2 Set up a method for single samples to identify compounds
3 Make sure the stop time is the same 
for all instrument modules.

Stop Time: same as pump

a On the selection tree, select the VWD folder.
b Under Stoptime select as Pump/Injector.
c On the selection tree, select the TCC folder.
d Under Stoptime, select as Pump/Injector.

Steps Detailed Instructions
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Basic Exercise #2 Set up a method for single samples to identify compounds
Task 3. Save and audit method changes

Steps Detailed Instructions

1 Save the method. 

After you save the method here, you 
can use the method to produce an 
example chromatogram.

See “Basic Exercise #2a Run a single 
sample to produce an example 
chromatogram” on page 17.

Continue with Task 4 after you 
produce an example chromatogram.

a On the Standard toolbar, click .

The Save Changes To The Database dialog box appears.

b Review the List of changes.
c Under Reason for changes, enter a reason or select a reason from the list.
d Click the Save button.

The Cerity administrator must set up auditing for the Save Changes to the 
Database dialog box to appear. The Cerity administrator can provide a list of 
reasons and require you to enter your electronic signature to complete the 
dialog box.
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Basic Exercise #2 Set up a method for single samples to identify compounds
Task 4. Select an example chromatogram and set up integration

Steps Detailed Instructions

1 Select an example chromatogram.

If no chromatogram of the isocratic 
sample exists, you must run a sample 
to produce the example 
chromatogram. See “Basic Exercise 
#2a Run a single sample to produce 
an example chromatogram” on 
page 17. 

You do not need the example 
chromatogram to set up integration 
and identification, but it is 
recommended.

a On the selection tree, expand the exer2iii method folder, if necessary.
b Expand the Data Analysis folder.
c Select Example Chromatogram.
d On the Tools toolbar, click .

e Expand the Samples folder.
f Expand the exchromiii or defexchrom2a folder.
g Select the sample name with the injection number.
h Click the Select button.

The example chromatogram appears in the workspace.
Cerity NDS Getting Started Guide 87



Basic Exercise #2 Set up a method for single samples to identify compounds
2 Change the initial event values so 
that there are only four integrated 
peaks.

a On the selection tree, select Integration under Data Analysis.

The example chromatogram appears with the integration events tables.

b Change the Height Reject event value to 1 (or the lowest value that will still 
integrate the four main peaks).

c Click  on the Actions toolbar

Steps Detailed Instructions
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Basic Exercise #2 Set up a method for single samples to identify compounds
Task 5. Set up compound identification

Steps Detailed Instructions

1 Set up the compound table for the 
following compounds:

RT=.9 to 1.1, dimethylphthalate

RT=1.1 to 1.2, diethylphthalate

RT=1.8 to 2.1, biphenyl

RT=3 to 3.2, o-terphenyl

a On the selection tree, select the Identification item for Data Analysis.
b On the Tools toolbar, click .

The peaks appear with the names New CompoundN in the compound table, 
where N = 1 - 4.

c Under Compound Name, select the first cell and enter dimethylphthalate.

After you select the cell, enter the name. The previous entry is overwritten.

d Under Compound Name, select the second cell and enter diethylphthalate.
e Under Compound Name, select the third cell and enter biphenyl.
f Under Compound Name, select the fourth cell and enter o-terphenyl.
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Basic Exercise #2 Set up a method for single samples to identify compounds
2 Save the method.

If you need to run this method to 
identify compounds before you set up 
the other methods in these exercises, 
use the method with “Basic Exercise 
#2b Run a group of single samples to 
identify compounds” on page 23.

a On the Standard toolbar, click .

The Save Changes To The Database dialog box appears.

b Review the List of changes.
c Under Reason for changes, enter a reason or select a reason from the list.
d Click the Save button.

The Cerity administrator must set up auditing for the Save Changes to the 
Database dialog box to appear. The Cerity administrator can provide a list of 
reasons and require you to enter your electronic signature to complete the 
dialog box.

Steps Detailed Instructions
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Basic Exercise #3
Set up a single-level calibrated method 
for a sequence

This exercise contains a series of tasks to learn how to: 

• Create a method template for a sequence to include 
single-level, single-update calibration and ESTD quantitation 

• Set up calibration and quantitation with fixed compound 
amounts

• Set up a sequence template

A sequence template is a sequence table containing the order of 
calibration standards and samples that you need to run with 
this method. A sequence template is useful if the order, sample 
names and characteristics are similar every time you run a 
sequence with this method.

You can use this method with “Basic Exercise #3a Run a 
sequence to quantify compounds with single-level calibration” 
and “Basic Exercise #3b Reintegrate and reprocess the results”.

For the tasks on the following pages, try the steps on the left 
without the detailed instructions. If you need more help, follow 
the detailed instructions on the right.

Before you start

Read “Setting Up Methods” on page 71 for setting up methods.
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
Task 1. Copy a method to create a method template for a sequence

Steps Detailed Instructions

1 Create a new method template from 
an existing method.

• Name the method template, 
exer3iii, where iii are your initials.

• Use exer2iii or defexer2 as the 
template for the new method 
template.

• Make sure that only Compound 
Identification and Calibration and 
Quantitation are marked.

You copy a method when you want to 
keep the instrument and data analysis 
settings from the old method. You do 
not have to take the time to enter the 
settings into the new method.

a Select File > New > Method or click  and select Method.

The Method Wizard New Method panel appears.

b Click the Browse button and select exer2iii or defexer2 from the Method 
Template Selection dialog box.

c Enter exer3iii in the New Method Name box.
d Select Sequence.

e Click Next until you reach the Data Analysis panel.
f Mark the Calibration and Quantitation check box.
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
2 Make selections to keep the 
compound table and set up new 
calibration.
• Make selections to set up:

single-level calibration
fixed compound amounts
single-update calibration
sequence-specific calibration

a Click Next to scroll to the Compound Table panel.
b Select the Keep Compound Calibration from Method template option.

This option lets you keep the compound table from the previous method 
(even though no calibration was set up). 

c Click Next to scroll to the Identification panel.
d Do not mark any check boxes on the Identification panel.
e Click Next to scroll to the Calibration panel.
f Select Fixed Amount and use the default options.

Steps Detailed Instructions
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
3 Set up Quantitation and review your 
new method.

a Click Next to scroll to the Quantitation panel.
b Make sure that the Limit checks check box is clear and the ESTD option is 

selected.

c Click Next to scroll to the New Method Review panel.
d Review the Method Wizard Settings.
e Click the Finish button to save your new method.

Steps Detailed Instructions
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
Task 2. Select an example chromatogram

Steps Detailed Instructions

1 Select an example chromatogram.
• Use the example chromatogram you 

produced with Basic Exercise 2a or 
2b of the “Basic Exercise #3a Run a 
sequence to quantify compounds 
with single-level calibration” and 
“Basic Exercise #3b Reintegrate 
and reprocess the results”. 

• Or, use defexchrom2a.

You do not need to select an example 
chromatogram. However, it is easier 
to modify compound identification if 
you do.

a On the selection tree, expand the exer3iii folder.
b Expand the Data Analysis folder.
c Select the Example Chromatogram item.
d On the Tools toolbar, click .

e Select the sample name with the injection number to produce the example 
chromatogram.

f Click the Select button.

The example chromatogram appears in the workspace.

After you have selected the example chromatogram, you can see the 
integration and identification settings that belong to the original method.
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
Task 3. Modify compound identification

Steps Detailed Instructions

1 Remove a compound from the 
compound table.

Remove the o-terphenyl compound.

a On the selection tree, select Identification under the Data Analysis folder.
b Select the o-terphenyl cell.
c Right-click the o-terphenyl cell and select Remove Compound.
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
Task 4. Set up calibration

Steps Detailed Instructions

1 Set up calibration for 
dimethylphthalate.

dimethylphthalate - 10µg

a On the selection tree, select Calibration under the Data Analysis folder.
b On the calibration table, select dimethylphthalate. 
c On the Options tab, enter 10 in the Weighed Amount box and µg in the 

Amount Unit box.
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
2 Set up calibration for biphenyl.

Biphenyl - 15µg

a On the calibration table, select biphenyl. 
b On the Options tab, enter 15 in the Weighed Amount box and µg in the 

Amount Unit box.

Steps Detailed Instructions
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
3 Remove diethylphthalate from the 
calibration table.

a On the calibration table, right-click anywhere and select Remove Compound 
from the shortcut menu.

The Select Compound(s) dialog box appears.

b In the Calibration Table list, select diethylphthalate.
c Click the < button to put diethylphthalate in the Available Compounds list.
d Click the OK button.

Steps Detailed Instructions
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
Task 5. Set up quantitation for all four peaks

Steps Detailed Instructions

1 Base the quantitation of 
diethylphthalate on 
dimethylphthalate.

Use an amount multiplier of .8.

a On the selection tree, select Quantitation Setup under the Data Analysis 
folder.

b Click the Uncalibrated Compounds tab.
c Under Compound Calibration Type, select the Use Compound option.
d Select dimethylphthalate from the Use Compound list.
e Enter .8 in the Amount Multiplier (Compound) box.
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
2 Base the quantification of the 
unidentified peak on biphenyl.

Use an amount multiplier of .9.

a Click the Unidentified Peaks tab.
b Under Use for Quantitation, select the Use Compound option.
c Select biphenyl from the Use Compound list.
d enter .9 in the Amount Multiplier (Unidentified Peak) box.

Steps Detailed Instructions
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
Task 6. Set up the sequence template

Steps Detailed Instructions

1 Enter the following calibration 
standards and samples into the 
sequence template:

Cal1- full-strength isocratic standard

Sample 1_2 - isocratic standard 
diluted 1/2 with methanol

Sample 1_4 - isocratic standard 
diluted 1/4 with methanol

NOTE

You cannot set up a sequence 
template with calibration standards 
until you have set up calibration in 
Data Analysis.

a On the selection tree, select Sequence Template for the method.
b On the sample table, enter the calibration standard for row one.

• Enter Cal1 in the Sample Name box.
• Select Calibration Standard from the Sample Type list.
• Enter the Vial# where this standard is located in the ALS.
• Click the Apply button to put the sample information into the sample table.

c Enter sample 1_2 for row two.
• Select Row 2 in the sample table.
• Enter sample 1_2 in the Sample Name box.
• Select Sample from the Sample Type list.
• Enter the Vial# where this sample is located in the ALS.
• Click the Apply button to put the sample information into the sample table.

d Enter sample 1_4 for row three. 
• Select Row 3 in the sample table.
• Enter sample 1_4 in the Sample Name box.
• Select Sample from the Sample Type list.
• Enter the Vial# where this sample is located in the ALS.
• Click the Apply button to put the sample information into the sample table.
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
2 Enter two more sets of Cal1, 
sample1_2 and sample 1_4 into the 
template.

Hint: Use the Fill Down Wizard and 
Copy command.

The standards and samples in the 
final template appear in the following 
order:

• calibration standard 
• two samples, 
• calibration standard 
• two samples, 
• calibration standard
• two samples

a Click Fill Down on the Edit toolbar, and select Fill Down Wizard.

The Fill Down Wizard appears.

b Under Range, select Append, enter 6, and click Next.

c On the Sample Names panel, enter cal1in the Name box, and click Next.
d On the Vial Numbers panel, clear the Define Vial numbers? check box, and 

click Finish.
e When the Apply Sample Changes dialog box appears, click Yes.

See that the six new rows display copies of the first row of the template.
f Select the two samples on lines 2 and 3, and click the Copy button on the Edit 

toolbar.
g Select rows 5 and 6, and click the Paste button on the Edit toolbar.
h Select rows 8 and 9, and click the Paste button on the Edit toolbar.

Steps Detailed Instructions
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Basic Exercise #3 Set up a single-level calibrated method for a sequence
3 Set how the calibration will be 
updated:

First Cal1- Replace (both RF and RT) 

Second Cal1 - Average for RF and 
Floating average for RT (Weighted 
60% after RT)

Third Cal1 - Average for RF and 
Floating average for RT (Weighted 
75% after RT)

a On the sequence table, select the first Cal1.
b Click the Run tab.
c Under Calibration, select Replace from the Response Factor Update list and 

select Replace from the Retention Time Update list.
d Select the second Cal1 in the sequence table.
e Select Average from the Response Factor Update list and Floating average 

from the Retention Time Update list.
f Select 60%.
g Repeat steps d and e for the third Cal1.

4 Save the method.

After you complete this method, you 
may use it to run a sequence. See 
“Basic Exercise #3a Run a sequence 
to quantify compounds with 
single-level calibration” on page 29 
and “Basic Exercise #3b Reintegrate 
and reprocess the results” on 
page 39.

a Click , and enter your reasons for changes and electronic signature, if 
necessary.

Steps Detailed Instructions
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Advanced Exercise #4
Set up a method for single samples to 
acquire and use spectra

This exercise contains a series of tasks to learn how to: 

• Create a method template for single samples and spectra, to 
include only compound identification in the method

• Set up and save the method to produce an example 
chromatogram

• Use an example chromatogram to set up integration

• Set up compound identification

• Set up UV compound confirmation

• Set up UV purity

• Set up spectra handling

Use the method created in the first part of this exercise to enter 
and run a single sample to produce an example chromatogram. 
You can use the completed method to enter and run a group of 
samples to identify compounds.

For the tasks on the following pages, try the steps on the left 
without the detailed instructions. If you need more help, follow 
the detailed instructions on the right.

Before you start

Read “Setting Up Methods” on page 71 for setting up methods.

NOTE You will need a detector capable of acquiring spectra (DAD or FLD) and a 
UV Spectral Acquisition license to complete this exercise.
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Advanced Exercise #4 Set up a method for single samples to acquire and use spectra
Task 1. Create a method template to identify compounds only

Steps Detailed Instructions

1 Create a new method template for a 
single sample.

Name the method template, exer4iii, 
where iii are your initials.

b Select File > New > Method or click  and select Method.

The Method Wizard appears.

c Enter exer4 in the Method Name box.
d Select Single Sample.

e Click Next to scroll to the Method Wizard Instrument panel.

2 Select an instrument for the method.

Select an instrument with either a 
DAD or an FLD.

a On the Instrument panel, select the instrument that will run the sample.
b Mark the UV Spectra check box.

c Click Next to scroll to the Data Analysis panel.
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Advanced Exercise #4 Set up a method for single samples to acquire and use spectra
3 Mark Compound Identification, UV 
Purity and UV Confirmation.

a On the Data Analysis panel, mark the UV Purity and UV Confirmation check 
boxes, and clear the Calibration and Quantification, Include Noise 
Calculations and Include System Suitability Calculations check boxes.

b Click Next to scroll to the Identification panel.

4 Complete the setup of the method 
template.

Do not mark any check box on the 
Method Wizard Identification panel.

a Click Next, and click the Finish button.
b Click Save if the Save Changes to the Database dialog box appears.

Steps Detailed Instructions
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Advanced Exercise #4 Set up a method for single samples to acquire and use spectra
Task 2. Enter the instrument conditions for the equilibrium

Steps Detailed Instructions

1 Enter the pump parameters:

Methanol as Solvent B:

• Flow rate: 2ml/min.
• Solvent composition: 

80%MeOH/20%H2O
• Stoptime: 5 min.

Acetonitrile as Solvent B:

• Flow rate: 1.5ml/min
• Solvent composition: 

65%ACN/35%H2O
• Stoptime: 5 min.

a On the selection tree, expand the exer4iii method folder.
b Expand the Instrument Setup folder and select the Quaternary Pump or 

Binary Pump.
c Enter the Flow as 2 ml/min.
d Under Solvents, mark the B check box and enter 80 in the % box.

The percent of solvent A is automatically set to 20 %.
e Under Stoptime, select the min option and enter 5.

2 Enter the injection volume and stop 
time for the autosampler.
• Injection Volume: 1µl
• Stop Time: As pump

a On the selection tree, select the ALS folder.
b Click the Auxiliary & Time tab.
c Under Stoptime, select the As pump option.
d Click the Setup tab and select Standard Injection.
e Enter 1µl for the Injection Volume.
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Advanced Exercise #4 Set up a method for single samples to acquire and use spectra
3 Make sure the stop time is the same 
for all instrument modules.

Stop Time: As pump/injector

a On the selection tree, select the DAD or FLD folder.
b Under Stoptime, select As pump/injector.
c On the selection tree, select the TCC folder.
d Under Stoptime, select As pump/injector.

4 Set up spectral acquisition 
parameters.

Signal

• A: 254 nm, Bw: 4 nm
• Reference: 400 nm, Bw: 100 nm

Spectrum

• Store: All
• Range: 190 nm
• to: 450 nm
• Step: 2 nm

a On the selection tree, select the DAD or FLD folder.
b Under Signal, mark the Store check box for Signal A, set the Sample 

wavelength to 254 nm and the Bw to 10
c Mark the On/Off check box and set the Reference wavelength to 400 and the 

Bw to 100.
d Under Spectrum, select to store All spectra, and set the Range from 190 to 

450 nm with a Step size of 2.

Steps Detailed Instructions
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Advanced Exercise #4 Set up a method for single samples to acquire and use spectra
Task 3. Save and audit method changes

Steps Detailed Instructions

1 Save the method. 

After you save the method here, you 
can use the method to produce an 
example chromatogram.

See “Basic Exercise #2a Run a single 
sample to produce an example 
chromatogram” on page 17.

Continue with Task 4 after you 
produce an example chromatogram.

a On the Standard toolbar, click .

The Save Changes To The Database dialog box appears.

b Review the List of changes.
c Under Reason for changes, enter a reason or select a reason from the list.
d Click the Save button.

The Cerity administrator must set up auditing for the Save Changes to the 
Database dialog box to appear. The Cerity administrator can provide a list of 
reasons and require you to enter your electronic signature to complete the 
dialog box.
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Advanced Exercise #4 Set up a method for single samples to acquire and use spectra
Task 4. Enter and run a single sample

Steps Detailed Instructions

1 Start the Instrument View to find the 
sample table for single samples. 

a Select Instrument from the Current View list.
b Expand the folder for the instrument that will produce the example 

chromatogram.
c Select Single Samples.

The sample table and sample entry panel appear in the workspace.

2 Enter a sample with the following 
information:
• Name the sample exchrom3Diii, 

where iii are your initials.
• Select either exer4iii 
• Select the vial that contains the 

full-strength isocratic standard.

a Enter exchrom3Diii in the Sample Name box.
b Select a method from the Method list.

The instrument associated with the method appears in the Instrument box.

c Select Sample from the Sample Type list.
d Enter the vial number for the sample in the Vial Number box.
e Click Apply to put the sample information in the sample table.
Use the default values for all other parameters

3 Enter the tasks to perform during the 
run.

a Clear the Quantify and Report check boxes.

4 Save the sample. a On the Standard toolbar, click .

The Save Changes To The Database dialog box appears.

b Review the List of changes.
c Under Reason for changes, enter a reason or select a reason from the list.
d Enter your electronic signature if required.
e Click the Save button.
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Advanced Exercise #4 Set up a method for single samples to acquire and use spectra
5 Run the sample. a On the selection tree, expand your instrument folder.
b Select Single Samples.
c Select the sample, exchromiii.

The Run button   becomes available on the Tools toolbar.

d Click the Run button.

You can also run the sample from the Sample View.

6 Monitor the signal, and track the 
status of the sample.

a On the selection tree, select your instrument.
b Click the Online Plot tab to view the signal. 

Change the axes if necessary.

See “Basic Exercise #2a Run a single sample to produce an example 
chromatogram” on page 17 for detailed instructions.

7 Review the sample result and make 
sure all four peaks are integrated. 

a Select Result from the Current View list.
b Select MySamplesRunLast24h from the Query list.
c Expand the Samples folder.
d Expand the exchrom3Diii folder.
e Select the exchrom3Diii #1 injection.
f View the chromatogram and results.

Steps Detailed Instructions
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Advanced Exercise #4 Set up a method for single samples to acquire and use spectra
Task 5. Select an example chromatogram and set up integration

Steps Detailed Instructions

1 Select an example chromatogram.

You do not need the example 
chromatogram to set up integration 
and identification, but it is 
recommended.

a On the selection tree, expand the exer4 method folder, if necessary.
b Expand the Data Analysis folder.
c Select Example Chromatogram.
d On the Tools toolbar, click .

e Expand the Samples folder.
f Expand the exchrom3Diii folder.
g Select the sample name with the injection number.
h Click the Select button.

The example chromatogram appears in the workspace.
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Advanced Exercise #4 Set up a method for single samples to acquire and use spectra
2 Change the initial event values so 
that there are only four integrated 
peaks.

a On the selection tree, select Integration under Data Analysis.

The example chromatogram appears with the integration events tables.

b Change the Height Reject event value to 1 (or the lowest value that will still 
integrate the four main peaks).

c Click  on the Actions toolbar

Steps Detailed Instructions
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Advanced Exercise #4 Set up a method for single samples to acquire and use spectra
Task 6. Set up compound identification

Steps Detailed Instructions

1 Set up the compound identification 
table for the following compounds:

RT=.9 to 1.1, dimethylphthalate

RT=1.1 to 1.2, diethylphthalate

RT=1.8 to 2.1, biphenyl

RT=3 to 3.2, o-terphenyl

a On the selection tree, select the Identification item for Data Analysis.
b On the Tools toolbar, click .

The peaks appear with the names New CompoundN in the compound table, 
where N = 1 - 4.

c Under Compound Name, select the first cell and enter dimethylphthalate.

After you select the cell, enter the name. The previous entry is overwritten.

d Under Compound Name, select the second cell and enter diethylphthalate.
e Under Compound Name, select the third cell and enter biphenyl.
f Under Compound Name, select the fourth cell and enter o-terphenyl.
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Advanced Exercise #4 Set up a method for single samples to acquire and use spectra
Task 7. Set up UV spectral compound confirmation

Steps Detailed Instructions

1 Set up UV spectral compound 
confirmation for all compounds

a On the Identification workspace, click the Confirmation tab.
b In the Confirmation table, select the first line.
c Mark the Use UV spectral compound confirmation check box in the panel 

below the table.
d Mark the Use default options check box in the panel below the table.
e Select the other lines in the Confirmation table, and repeat (c) and (d) for 

each compound.

Note that when the checkboxes are marked, a plus sign is entered into the 
Use UV spectral compound confirmation and Use Defaults columns of the 
Confirmation table
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Advanced Exercise #4 Set up a method for single samples to acquire and use spectra
2 Set up the default UV spectral 
compound confirmation options

a In the panel below the Confirmation table, click the ... button to the right of 
the Use default options check box.

The Spectral Confirmation Defaults dialog box appears.

b In the Background Correction group, select the Automatic option.
c In the Calculations group, set the Noise threshold to 5 mAU.
d Leave the Levels at their default values.

3 Select a reference spectrum for 
confirmation

a On the Standard toolbar, click .

The Compound Reference Spectrum Selection dialog box for the selected 
compound appears.

b On the selection tree, expand the exchrom3Diii folder. 
c Select the sample name with the injection number.
d On the dialog box toolbar, click .
e On the example chromatogram, select the peak for the selected compound.

The apex spectrum of the selected compound is displayed in the spectrum 
window.

f From the Compound drop-down list, select the next compound.
g Select the peak for this compound.
h Repeat (f) and (g) for all remaining compounds.
i Close the Compound Reference Spectrum Selection dialog box.

Steps Detailed Instructions
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Advanced Exercise #4 Set up a method for single samples to acquire and use spectra
Task 8. Set up UV purity

Steps Detailed Instructions

1 Set up Spectra Handling parameters
• Set up the Wavelength Range
• Set up Background Correction
• Set up Peak Spectra
• Set up Calculations
• Set up Levels

a On the selection tree, select the UV Purity item for Data Analysis.

The UV purity options panel is displayed in the workspace.

b In the Wavelength Range group, mark the Low check box and enter 220 in 
the adjacent field.

c In the Background Correction group, select the Automatic option.
d In the Peak Spectra group, set the Number of spectra to 7. Leave the 

Minimum response range at its default value.
e In the Calculations group, set the Noise threshold to 5 mAU.
f Leave the Levels at their default values.
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Advanced Exercise #4 Set up a method for single samples to acquire and use spectra
Task 9. Set up spectra handling

Steps Detailed Instructions

1 Set up UV Purity parameters
• Set up the Wavelength Range
• Set up Background Correction
• Set up Peak Spectra

a On the selection tree, select the Spectra Handling item for Data Analysis.

The spectra handling options panel is displayed in the workspace.

b In the Wavelength Range group, clear both check boxes.

This ensures that the complete wavelength range is displayed.

c In the Background Correction group, select the Automatic option.
d In the Peak Spectra group, set the Number of spectra to All. Leave the 

Minimum response range at its default value.
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Advanced Exercise #4 Set up a method for single samples to acquire and use spectra
2 Save the method. a On the Standard toolbar, click .

The Save Changes To The Database dialog box appears.

b Review the List of changes.
c Under Reason for changes, enter a reason or select a reason from the list.
d Click the Save button.

The Cerity administrator must set up auditing for the Save Changes to the 
Database dialog box to appear. The Cerity administrator can provide a list of 
reasons and require you to enter your electronic signature to complete the 
dialog box.

Steps Detailed Instructions
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Advanced Exercise #5
Set up a multi-level calibrated method 
for a sequence

This exercise contains a series of tasks to learn how to: 

• Use an existing method to create a new method template for 
a sequence

• Include multi-level, overall calibration and ESTD 
quantitation in the method

• Set up calibration and quantitation with variable compound 
amounts for a calibration table with two levels

• Set up system sample variables

• Set up a sequence template for overall calibration

• Select a new report template for a single standard injection 
report

See “Basic Exercise #3 Set up a single-level calibrated method 
for a sequence” on page 91 to learn what a sequence template is.

You can use this method with “Advanced Exercise #4a Run a 
sequence to quantify compounds with multi-level 
calibration” on page 45 and “Advanced Exercise #4b Change 
sample variables in the method and reprocess” on page 53.

For the tasks in this exercise, try the steps on the left without 
the detailed instructions. If you need more help, follow the 
detailed instructions on the right.

Before you start

Read “Setting Up Methods” on page 71 to set up methods.
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Advanced Exercise #5 Set up a multi-level calibrated method for a sequence
Task 1. Copy a method to create a new method template for a sequence

Steps Detailed Instructions

1 Copy the method to create a new 
template.
• Copy either exer3iii or defexer3.
• Name the method template, 

exer4iii, where iii are your initials.
• Change nothing until you reach the 

Compound Table panel.

Note that the Method Wizard panels 
contain the method selections from 
Exercise 3.

a Select File > New > Method or click  and select Method.

The Method Wizard appears.

b On the New Method panel, click the Browse button, and select exer3iii or 
defexer3.

c Enter exer4iii in the New Method Name box.

d Click Next until you reach the Compound Table panel.

2 Set up the Compound Table panel.

Because you will set up a multi-level 
calibration, you set up a new 
calibration table.

a On the Compound Table panel, select Set up a new Compound Calibration.

b Click Next until you reach the Calibration panel.
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Advanced Exercise #5 Set up a multi-level calibrated method for a sequence
3 Set up the calibration panel.

Choose to set up:

• multi-level calibration (2 levels)
• variable compound amounts
• overall calibration
• sequence-specific calibration

a Select Variable Amount.
b Mark the Multi Level check box, and enter 2 levels.
c Select Overall Calibration.

d Click Next until you reach the New Method Review panel.

4 Review your new method template. a On the New Method Review panel, review the Method Wizard Settings.
b Click the Finish button to save your new method.
c Save all changes to the database, with a reason if necessary.

Steps Detailed Instructions
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Advanced Exercise #5 Set up a multi-level calibrated method for a sequence
Task 2. Set up example chromatogram and compound identification

Steps Detailed Instructions

1 Select an example chromatogram.

Use the example chromatogram that 
you produced with “Basic Exercise 
#3a Run a sequence to quantify 
compounds with single-level 
calibration” and “Basic Exercise #3b 
Reintegrate and reprocess the 
results”. 

Or, use defexchr2a. (To use this 
chromatogram, use an instrument 
with a VWD detector.)

If you cannot see the sample whose 
chromatogram that you want to 
select, select another query.

Hint: The result, defexchr2a, is a 
restored result.

a On the selection tree, expand the new method template, exer4iii.
b Expand the Data Analysis folder and select Example Chromatogram.
c On the Tools toolbar, click .

The Select example chromatogram dialog box appears.

d Select the injection from the analysis that contains the example 
chromatogram for the new method. If you do not see the defexchrom2a under 
the Samples folder, select the query, AllResultsRestored.

e Click the Select button.

The example chromatogram appears in the workspace.

The integration parameters are retained from the Exercise 3 method. You do 
not have to set up integration.
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Advanced Exercise #5 Set up a multi-level calibrated method for a sequence
2 Set up the compound table for these 
compounds:

RT=0.9-1.1 min, dimethylphthalate

RT=1.1-1.3 min, diethylphthalate

RT=1.8-2.0 min, biphenyl

Do not identify the fourth peak. In 
another exercise, you will set up the 
fourth peak as an unspecified impurity 
that is not identified based on 
retention time.

a On the selection tree, select Identification under the Data Analysis folder.
b On the Tools toolbar, click .

The peaks appear with the names New Compound one through four in the 
compound table.

c Under Compound Name, select the first cell and enter dimethylphthalate.

After you select the cell, enter the name. The previous entry is overwritten.

d Under Compound Name, select the second cell and enter diethylphthalate.
e Under Compound Name, select the third cell and enter biphenyl.
f Under Compound Name, right-click the fourth cell.
g Select Remove Compound.

On the Identification workspace, view the three identified peaks and one 
unidentified peak.

Steps Detailed Instructions
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Advanced Exercise #5 Set up a multi-level calibrated method for a sequence
Task 3. Set up calibration and quantitation

Steps Detailed Instructions

1 Set up calibration for 
dimethylphthalate and biphenyl.

Default amounts for 
dimethylphthalate:

• Level 1 - 10µg
• Level 2 - 40µg

Default amounts for biphenyl:

• Level 1 - 15µg
• Level 2 - 60µg

When you set up a method with 
variable compound amounts, the 
application lets you enter the actual 
weight (concentration) of the 
standard compounds in sample entry.

a On the selection tree, select Calibration under the Data Analysis folder.
b On the Compounds table, select dimethylphthalate. 
c On the Options sheet, click the Use Default Amount cell and select +.

When you make this selection, the amount that you enter in the Weighed 
Amount cell for each level appears in the Amounts sheet in Sample Entry. 

d For level 1, enter 10 in the Weighed Amount box and µg in the Amount Unit 
box.

e For level 2, enter 40 in the Weighed Amount box. 
f Repeat steps c-e for biphenyl.
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Advanced Exercise #5 Set up a multi-level calibrated method for a sequence
2 Remove diethylphthalate from the 
calibration table.

The system has automatically added 
all compounds from the compound 
identification table to the calibration 
table. 

In this step, remove diethylphthalate 
to use it as an uncalibrated compound 
that is quantified based on the 
response factors of a different 
compound.

a On the calibration table, right-click anywhere and select Remove Compound 
from the shortcut menu.

The Select Compounds dialog box appears.

b In the Calibration Table list, select diethylphthalate.
c Click the < button to put diethylphthalate in the Available Compounds list.
d Click the OK button.

3 Set up quantitation as you did in 
Exercise 3.

See “Task 5. Set up quantitation for all four peaks” on page 100.

Steps Detailed Instructions
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Advanced Exercise #5 Set up a multi-level calibrated method for a sequence
Task 4. Set up system sample variables

Steps Detailed Instructions

1 Set up a multiplier called “dilution 
factor”.

Use a default value of 5.

a On the selection tree, select Sample Variables.
b Double-click the Dilution cell, and add the word Factor.
c Enter a default value of 5.

2 Set up a divisor called “correction 
factor”.

Use a default value of 2.

a Click the Divisor cell once, and enter the name, Correction Factor.
b Enter a default value of 2.
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Advanced Exercise #5 Set up a multi-level calibrated method for a sequence
Task 5. Edit the sequence template

Steps Detailed Instructions

1 Edit the template to look like this:
• two calibration standards (Lev1,2)
• two samples, 
• two calibration standards 
• two samples, 
• two calibration standards

NOTE

You cannot set up or edit a 
sequence template with 
calibration standards until you set 
up calibration in Data Analysis.

Note that the sequence template still contains the information for the method 
from Exercise 3 but no longer identifies calibration standards.
a On the selection tree, select Sequence Template.
b On the sample table, select the calibration standard for row one.
c Select Calibration Standard from the Sample Type list.
d Move to another row or click the Apply button.
e Repeat steps b-d for the next two standards.
f Select the standard in the first row.
g Click the Insert button in the toolbar.
h Change the Sample Name of the second standard to Cal2.
i Set the Vial# to 3 and the Calibration Level to 2.
j Click Apply.
k Repeat steps g-j for the next two standards.
l Select the last two sample rows, and click the Delete button.

2 Set up to quantify the first sample, 
Sample 1_2, immediately.

When you make this selection, 
Sample 1_2 will be quantified using 
the first set of calibration standards. 
Sample 1_2, along with the other 
samples, will also be quantified at a 
later time using the average of all the 
calibration standards.

a Double-click the cell for Sample 1_2 under the heading, Immediate 
Quantitation.

b Double-click the Yes that appears.
Cerity NDS Getting Started Guide 129



Advanced Exercise #5 Set up a multi-level calibrated method for a sequence
3 Use the default compound amounts 
for all standards.

a Click the Amounts tab on the Sample Entry panel
b For each calibration standard:

• Select the standard in the sequence table.
• Under Compound amounts, mark the Use check boxes for 

dimethylphthalate and biphenyl.

Steps Detailed Instructions
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Advanced Exercise #5 Set up a multi-level calibrated method for a sequence
Task 6. Select a new report template for a report

Steps Detailed Instructions

1 Select a report template for a single 
standard injection report

a On the selection tree, select Reporting.
b On the Reporting table, select the Standard single injection report type.
c Click the Select Template... button.

The Select Report Template dialog box appears.
d On the Select Report Template dialog box, select the template for the 

Standard Single Injection Detailed report.
e Click OK.

2 Select these report types to print:
• Sample single injection
• Standard single injection
• Sequence

a Double-click the Print cell for the Multi-Injection Summary Group report to 
change Yes to No.

b Repeat step a for the Calibration Standards Group report to change Yes to No.

3 Save the method. a On the Standard toolbar, click , and enter your reasons for changes and 
electronic signature, if required.
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Advanced Exercise #6
Set up a method for a sequence to 
quantify impurities 

This exercise contains a series of tasks to learn how to: 

• Include custom, noise and system suitability calculations in 
the method for a sequence

• Include bracketed calibration and ISTD quantitation in the 
method

• Set up a custom calculation to average the percent impurities 
of all the samples in the sequence over multiple injections

• Set limits for custom and system suitability calculations

• Set up a sequence template for bracketing, multiple 
injections and a blank run for a S/N calculation

• Set up the Result View layout to see the custom and system 
suitability calculations.

• Edit a report template for a sample group report to include 
the custom and system suitability calculations

You can use this method with “Advanced Exercise #5a Run a 
sequence to quantify impurities” on page 61 and “Advanced 
Exercise #5b Use a different method to reprocess” on page 67.

In the tasks in this exercise, try the steps on the left without the 
detailed instructions. If you need more help, follow the detailed 
instructions on the right.

Before you start

Read “Setting Up Methods” on page 71 to set up methods.
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Advanced Exercise #6 Set up a method for a sequence to quantify impurities
Task 1. Copy a method to create a new method template for a sequence

Steps Detailed Instructions

1 Copy the method to create a new 
template.
• Copy either exer4iii or defexer4iii. 

You can use the original method 
from Exercise 4 or the modified 
method from Exercise 4b.

• Name the method template, 
exer5iii, where iii are your initials.

Note that the Method Wizard panels 
contain the method selections in 
Exercise 4.

a Select File>New>Method or click  and select Method.

The Method Wizard appears.

b Click the Browse button, and select exer4iii or defexer4iii.
c Enter exer5iii in the New Method Name box.

d Click Next until you reach the Data Analysis panel.
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Advanced Exercise #6 Set up a method for a sequence to quantify impurities
2 Include the capability to set up 
custom calculations and system 
suitability calculations

a On the Data Analysis panel, mark the Custom Calculations check box.
b Mark the Include Noise Calculations check box.

Note that when you mark the Include Noise Calculations check box, the 
Include System Suitability check box appears marked and dimmed.

c Click Next to scroll to the Compound Table panel.

3 Select a Compound Table option.

Even though you are changing the 
mode of calibration to Bracketing, you 
can keep the calibration setup from 
Exercise 4.

a On the Compound Table panel, Select Keep Compound Calibration from 
Method template.

b Click Next until you reach the Calibration panel.

Steps Detailed Instructions
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Advanced Exercise #6 Set up a method for a sequence to quantify impurities
4 Select Calibration options.

Select Bracketing and keep all other 
options the same.

a On the Calibration panel, select Bracketing.

b Click Next to scroll to the Quantitation panel.

5 Select Quantitation options a On the Quantitation panel, mark the Limit checks check box.
b Select ISTD.

c Click Next to scroll to the New Method Review panel.

6 Review your new method template.

The new method contains the same 
data analysis and sequence template 
information as in the method for 
Exercise 4.

a On the New Method Review panel, review the Method Wizard Settings.
b Click the Finish button to save your new method.
c Save the changes to the database, with a reason, if necessary.

Steps Detailed Instructions
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Advanced Exercise #6 Set up a method for a sequence to quantify impurities
Task 2. Edit quantitation for an internal standard

Steps Detailed Instructions

1 Set up the ISTD quantitation.

Set biphenyl as the internal standard 
and use it for the quantitation of 
dimethylphthalate.

a Expand the method that you just created, and expand the Data Analysis 
folder.

b On the selection tree, select Quantitation Setup.
c Click the Calibrated Compounds tab.
d On the calibration table, select biphenyl.
e Under Internal Standard, mark Set this Compound as the ISTD.
f Select dimethylphthalate.
g Under Internal Standard, mark Use ISTD compound.
h Click the down arrow, and select biphenyl from the list.
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Advanced Exercise #6 Set up a method for a sequence to quantify impurities
Task 3. Set up a custom calculation to average the percent impurities of 
all the samples in a sequence

Steps Detailed Instructions

1 Set up to calculate the percent of 
impurity in each single injection.

The isocratic standard is a well-defined 
sample with known compounds. To help 
you learn how to set up a custom 
calculation, pretend that the 
composition of the isocratic standard is 
the following:

Main compound - dimethylphthalate

Specified impurity - diethylphthalate

ISTD - biphenyl

Unspecified impurity - unknown peak

You can also point and drag the cell 
reference to specify the cells in the 
calculation.

a In the selection tree, select Custom Calculations under Data Analysis.
b Click the Single Injection tab, if necessary.
c Add a column that contains the Amount variable for all compounds/peaks.

• Right-click the table, and select Add Column.

• In the Existing Column sheet, expand Compounds and select Amount.

• Click Apply.
d Add a column for the percent specified impurity calculation.

• Click the Add a New Custom Calculation Column tab.
• Enter the Variable ID for the specified impurity as anything you want, e.g. 

PercentSpecifiedImpurity (no spaces).

• Enter the Display Name, e.g., Percent Specified Impurity.

• Select the Level as Single Inj. Variables, then click Apply.
e Add a column for the percent unspecified impurity calculation.

• Enter the Variable ID, the Display Name, and select the Level as Single Inj. 
Variables, and click OK.

f Enter the formula for the percent specified impurity calculation into the Single 
Inj. Variables cell.
• Enter the syntax =D8/SUM(D7:D13)*100, which represents the 

amount of diethylphthalate divided by the sum of the amounts of all the peaks 
x 100. You can use the fx button to find the SUM function, or you can type 
SUM.

g Enter the formula for the percent unspecified impurity calculation into the 
Single Inj. Variables cell. (Use same syntax as for the specified impurity.)
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Advanced Exercise #6 Set up a method for a sequence to quantify impurities
2 Set up to calculate the average percent 
of impurity for all injections of a 
sample.

Do this for both the specified and 
unspecified impurity.

a On the Custom Calculations workspace, click the Multi-injection tab.
b Add a column for percent specified impurity.

• Right-click the table, and select Add Column.
• On the Existing Column sheet, expand User Defined, and select Percent 

Specified Impurity.
• Click Apply.

c Add a column for the percent unspecified impurity.
• Select Percent Unspecified Impurity.
• Click Apply.

d Add a column for the average of the percent specified impurity for all injections.
• Click the Add a New Custom Calculation Column tab.
• Enter the Variable ID as anything you want, e.g., AvgPercentSpecified.
• Enter the Display Name as a variant of the ID, e.g., Avg Percent Specified.
• Enter the Level as Multiple Inj. Variables, and click Apply.

e Add a column for the average of the percent unspecified impurity for all 
injections of a sample.
• Enter the Variable ID, Display Name and Level as Multiple Inj. Variables.
• Click OK.

f Enter the formula for the average of the percent specified impurity into the 
Multiple Inj. Variable cell.
• Enter the syntax =AVERAGE(D6:D8), which represents the average of the 

percent impurity calculation for each sample or all injections. You can use the 
fx button to access the AVERAGE function, or you can type AVERAGE.

g Enter the formula for the average of the percent unspecified impurity.

Steps Detailed Instructions
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Advanced Exercise #6 Set up a method for a sequence to quantify impurities
3 Set up to calculate the average percent 
of impurity for all samples.

Do this for both the specified and 
unspecified impurity.

a Click the Sample Group tab in the Custom Calculations workspace.
b Add a column for average percent specified impurity.

• Right-click the table, and select Add Column.
• Expand User Defined, and select Avg Percent Specified.
• Click Apply.

c Add a column for the average percent unspecified impurity.
• On the Existing Column sheet, expand User Defined, and select Avg Percent 

Unspecified.
• Click Apply.

d Add a column for the average of the percent specified impurity for all samples.
• Click the Add a New Custom Calculation Column tab.
• Enter the Variable ID as anything you want, e.g., AvgPercentSAllSamples.
• Enter the Display Name as a variant of the ID, e.g., Avg % S All Samples.
• Enter the Level as Sample Group Variables, and click Apply.

e Add a column for the average of the percent unspecified impurity for all 
samples, e.g., AvgPercentUAllSamples.
• Enter the Variable ID, Display Name and Level as Sample Group Variables.
• Click OK.

f Enter the formula for the average of the percent specified impurity.
• Enter the syntax =AVERAGE(F6:F8), which represents the average of the 

percent impurity calculation for all samples. You can use the fx button to 
access the AVERAGE function, or you can type AVERAGE.

g Enter the formula for the average of the percent unspecified impurity for all 
samples.

Steps Detailed Instructions
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Advanced Exercise #6 Set up a method for a sequence to quantify impurities
Task 4. Set up limits for the custom and system suitability calculations

Steps Detailed Instructions

1 Set up limits for system suitability 
calculations
• If tailing factor > than 1.7, then say 

Not Passed - all samples and only 
dimethylphthalate

• If USP resolution < than 1.5, then 
say Not Passed - all samples and all 
compounds

• If signal to noise is less than 5, then 
say Not Passed.

a Select Limits under Data Analysis.
b Make sure the Single Injection sheet appears.
c Right-click the Limits table, and select Insert New Limit.
d Expand the Peak folder, and select TailingFactor.
e From the Condition list, select >, and for Value, enter 1.7.
f From the Apply to list, select dimethylphthalate, and click OK.
g Repeat steps c and d for Peak resolution USP.
h From the Condition list, select < , and for Value, enter 1.5.
i Click OK.
j Repeat steps c and d for SignalToNoise.
k From the Condition list, select <, and for Value, enter 5.
l Click OK.

2 Set up limits for both the average of 
the specified impurity and the 
average of the unspecified impurity 
for all samples.
• If specified impurity > 10%, not 

passed
• If unspecified impurity > 5%, not 

passed

Hint: The tab Summary Groups let you 
set limits for all the variables and 
calculations associated with 
sample-type groups, such as sample 
group, calibration standard group, 
custom sample group and QC group.

a Click the Summary Groups tab.
b Right-click the table, and select Insert New Limit.
c In the Insert New Limit dialog box, expand the Single Values folder and select 

Avg % S All Samples.
d From the Data Set list, select Sample.
e From the Condition list, select >.
f Enter a value of 10, and click OK.
g Repeat steps b-f for the Avg % U All Samples and a value of 5.
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Advanced Exercise #6 Set up a method for a sequence to quantify impurities
Task 5. Edit the sequence template for bracketing and multiple injections

Steps Detailed Instructions

1 Set up the brackets
• Quantify the first set of samples 

with the average RFs of the first and 
second sets of standards.

• Quantify the second set of samples 
with the average RFs of the second 
and third set of standards.

a Select Sequence Template in the selection tree.
b Double-click the Bracketing cell for Cal1 in row 1, and double-click Open.
c Double-click the Bracketing cell for Cal1 in row 5, and double-click Open.
d Double-click the Bracketing cell for Cal2 in row 6, and double-click Close.
e Double-click the Bracketing cell for Cal2 in row 10, and double-click Close.

2 Enter a blank sample in the first row 
and enter two injections for each 
sample.

a Select row 1, and click the Insert button. (Use tooltip.)
b Enter NoiseBlank for the Sample Name, and select Blank Run for the Sample 

Type.
c Enter a different Vial#, and click Apply.
d Enter 2 for the Injections # for each sample in the sequence.
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Advanced Exercise #6 Set up a method for a sequence to quantify impurities
Task 6. Set up the Result View layout to see custom and system 
suitability calculations

Steps Detailed Instructions

1 Set up to view the percent specified 
impurity and the percent unspecified 
impurity.

a On the selection tree, expand the Data Review Layout folder.
b Select Single Injection in the selection tree.
c Select Summary Table in the workspace.
d Select Percent Specified Impurity from the Available Items list, and click > to 

move it to the Display Items list.
e Repeat step d for Percent Unspecified Impurity, and click Apply.

2 Set up to view the tailing factor, USP 
resolution and the S/N for each 
compound.

a Select the Results Table.
b Select Tailing Factor from the Available Items list, and click > to move it to 

the Display Items list.
c Repeat step b for Peak resolution USP and SignalToNoise, and click Apply.

3 Set up to view the average of the 
specified impurity and the average of 
the unspecified impurity for each 
sample.

a In the selection tree, select Multiple Injection.
b Select the Summary Table in the workspace.
c Select Avg Percent Specified from the Available Items list, and click > to 

move it to the Display Items list.
d Repeat step b for Avg Percent Unspecified, and click Apply.
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Advanced Exercise #6 Set up a method for a sequence to quantify impurities
4 Set up to view the average of the 
percent specified and unspecified 
impurities in all the samples and 
their limit checks.

a Select Samples in the selection tree.
b Select Summary Table in the workspace.
c Select Avg % S All Samples from the Available Items list, and click > to move 

it to the Display Items list.
d Repeat step c for Avg % U All Samples, Avg % S All Samples Limit Check and 

Avg % U All Samples Limit Check.
e Click Apply.

Steps Detailed Instructions
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Advanced Exercise #6 Set up a method for a sequence to quantify impurities
Task 7. Edit a report template for the sample group

Steps Detailed Instructions

1 Edit a report template for a sample 
single injection report.
• Edit the inj.html report.
• Add a column for USP resolution 

and Signal to Noise to the existing 
compounds table under the 
chromatogram.

• Save the template as exer5injiii, 
where iii is your initials.

a On the selection tree, select Reporting.
b Select the Sample single injection report type, and click Edit Template....
c Double-click Individual Report Templates, and double-click inj.html.
d Place the cursor in the last column of the compounds table located beneath 

the chromatogram.
e Right-click the table, and select Table Properties.

The Compound Table Properties dialog box appears.
f In the Select Column Fields list, mark the Peak resolution USP and 

SignalToNoise check boxes, and click OK.

The compound table in the resulting template looks like this:

g Select File > Save As, enter exer5injiii, and click OK.
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Advanced Exercise #6 Set up a method for a sequence to quantify impurities
2 Edit the sample group detailed report 
template (sus_d.html).
• Insert an html table under the 

Sample group variables table.
• Enter the text for the Avg. % S 

Impurity All Samples and Avg% U 
Impurity All Samples.

• Enter the placeholder for the values 
for the % impurities.

• Under the Sample Group Limits 
table, enter the Limit check 
information for the sample group.

• Save the template as exer5sgiii, 
where iii are your initials.

After you finish, the template displays 
as the Sample group template 

a Exit the Report Template Editor.
b Select the Sample Group report type, and click Edit Template....
c Double-click Individual Report Templates, and double-click sus_d.html.
d Insert a line below the Sample group variables table, and click the Insert 

HTML table button.
e In the Insert Table dialog box, select the Classic Table Style and click OK.
f Click the Fields tab and expand the Sample Group folder.
g Expand the Sample Group Variables Results folder. 
h Place the cursor into the first cell of the HMTL table, press the Alt key and 

double-click Avg % S All Samples.
i Place the cursor into the second cell in the first row and double-click Avg % S 

All Samples.
j Repeat steps h and i for Avg % U All Samples, using the second row.
k Place the cursor below the Sample group limit results table.
l Press the Ctrl key and double-click Avg % S All Samples Limit Check.
m Do the same for Avg % U All Samples Limit Check.
n Select File > Save As, enter exer5sgiii and click Save.

Steps Detailed Instructions
146 Cerity NDS Getting Started Guide



Advanced Exercise #6 Set up a method for a sequence to quantify impurities
Task 8. Select report templates and report types

Steps Detailed Instructions

1 Select report templates for report 
types.
• Use exer5injiii for the Sample single 

injection report.
• Use exer5sgiii for the Sample group 

report.

a Exit the Cerity Report Template Editor.
b Select the Sample single injection report type and click Select Template....
c Select exer5injiii and click OK.
d Select the Sample group report type and click Select Template....
e Select exer5sgiii and click OK.

2 Select these report types to print.
• Sample single injection
• Standard single injection
• Multi-injection summary
• Sample group
• Sequence

a Double-click the Print cell for the Multi-Injection Summary Group report to 
change No to Yes.

b Repeat instruction (a) for the Sample Group report to change Yes to No.

3 Save the method On the Standard toolbar, click , and enter your reasons for changes and 
electronic signature, if necessary
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Advanced Exercise #6 Set up a method for a sequence to quantify impurities
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Advanced Exercise #7
Calculate the mean area sum of the 
unidentified impurities per lot

This exercise contains a series of tasks to learn how to set up a 
custom calculation to calculate the mean of the area sum of the 
unidentified impurities per lot of samples: 

• Set up to sum the peak areas of the unidentified peaks in a 
single injection

• Set up to average the area sums of the unidentified peaks for 
all injections of a sample

• Set up to calculate the mean area sum for the samples in the 
sample group

NOTE You do not have to identify compounds to set up this calculation so that 
you can practice the instructions on an empty method.
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Advanced Exercise #7 Calculate the mean area sum of the unidentified impurities per lot
Task 1. Set up to sum the peak areas of the unidentified peaks in a single 
injection

Steps Detailed Instructions

1 On the single injection worksheet, 
add a column to contain the existing 
integration result, peak area.

a On the selection tree, expand the folder for the relevant method.
b Expand the Data Analysis folder.
c Select Custom Calculations.
d In the custom calculator workspace, click the Single Injection tab.
e Right click in the worksheet and select Add Column from the context menu.

The Add Column dialog box appears.

f In the Existing Column tab, expand the Peaks section and select Peak Area. 
Click OK to close the dialog box.

The workspace now contains a column with the peak areas for the not identified 
peaks.
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Advanced Exercise #7 Calculate the mean area sum of the unidentified impurities per lot
2 Add a column to contain the new 
calculation for the area sum of the 
unidentified peaks.

a Right click in the worksheet and select Add Column from the context menu.

The Add Column dialog box appears.

b Click the Add a new Custom Calculation Column tab.
c Enter Area Sum Not Ident Peaks in the Display Name field. 
d Click the Level down arrow and select Not Identified Peaks Summary.

The workspace now contains a column for the new variable Area Sum Not Ident 
Peaks.

3 Enter the formula for the area sum of 
the unidentified peaks. 

a In the Not Identified Peaks summary line of the new column, enter the 
formula to sum the areas of the unidentified peaks.

Hint: Use the syntax, =SUM(D8:D10).

Steps Detailed Instructions
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Advanced Exercise #7 Calculate the mean area sum of the unidentified impurities per lot
Task 2. Set up to average the area sums of the unidentified peaks for all 
injections of a sample

Steps Detailed Instructions

1 On the multi-injection summary 
worksheet, add a column to contain 
the variable set up in the single 
injection worksheet, the area sum of 
the unidentified peaks.

a In the custom calculator workspace, click the Multi Injection tab.
b Right click in the worksheet and select Add Column from the context menu.

The Add Column dialog box appears.

c In the Existing Column tab, expand the User Defined section and select Area 
Sum Not Ident Peaks. Click OK to close the dialog box.

The workspace now contains a column with the area sum for the unidentified 
peaks.

2 Add a column to contain the new 
calculation for the mean of the area 
sums of the unidentified peaks for all 
the injections.

a Right click in the worksheet and select Add Column from the context menu.

The Add Column dialog box appears.

b Click the Add a new Custom Calculation Column tab.
c Enter Mean Area Sum Not Ident Peaks in the Display Name field. 
d Click the Level down arrow and select Not Identified Peaks Variables.

The workspace now contains a column for the new variable Mean Area Sum 
Not Ident Peaks.
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Advanced Exercise #7 Calculate the mean area sum of the unidentified impurities per lot
3 Enter the formula for the mean of the 
area sums of the unidentified peaks 
for all the injections.

a In the Not Identified Peaks variables line of the new column, enter the 
formula to average the area sums of the unidentified peaks.

Hint: Use the syntax, =AVERAGE(D8:D10).

Steps Detailed Instructions
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Advanced Exercise #7 Calculate the mean area sum of the unidentified impurities per lot
Task 3. Set up to calculate the mean area sum for the samples in the 
sample group

Steps Detailed Instructions

1 On the sample group worksheet, add 
a column to contain the variable set 
up in the multi- injection worksheet, 
the mean of the area sums for all 
injections.

a In the custom calculator workspace, click the Sample Group tab.
b Right click in the worksheet and select Add Column from the context menu.

The Add Column dialog box appears.

c In the Existing Column tab, expand the User Defined section and select 
Mean Area Sum Not Ident Peaks. Click OK to close the dialog box.

The workspace now contains a column with the mean area sum for the not 
identified peaks.

2 Add a column to contain the new 
calculation for the mean of the area 
sums of the unidentified peaks for a 
sample lot.

a Right click in the worksheet and select Add Column from the context menu.

The Add Column dialog box appears.

b Click the Add a new Custom Calculation Column tab.
c Enter Mean Area Sum Lot in the Display Name field. 
d Click the Level down arrow and select Not Identified Peaks Variables.

The workspace now contains a column for the new variable Mean Area Sum Per 
Lot.
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Advanced Exercise #7 Calculate the mean area sum of the unidentified impurities per lot
3 Enter the formula for the mean of the 
area sums for the lot.

a In the Not Identified Peaks variables line of the new column, enter the 
formula to average the area sums of the unidentified peaks.

Hint: Use the syntax, =AVERAGE(D8:D10).

Steps Detailed Instructions
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Advanced Exercise #7 Calculate the mean area sum of the unidentified impurities per lot
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Agilent Cerity Networked Data System for Pharmaceutical QA/QC
Getting Started Guide
Advanced Exercise #8
Set up a Group Identifier with 
calculations for system suitability

This exercise contains a series of tasks to learn how to set up a 
custom calculation to calculate the ratio of the resolutions of 
the first and last peaks, and stop the sequence if it falls outside 
a defined range: 

• Set up a method to include System Suitability Calculations

• Set up the custom calculations for the system suitability test

• Set up the limit conditions

• Identify the system suitability samples in the sequence table
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Advanced Exercise #8 Set up a Group Identifier with calculations for system suitability
Task 1. Set up a method to include System Suitability Calculations

Steps Detailed Instructions

1 Create a new sequence method
• Name the method ssmethiii, where 

iii are your initials.
• Use exer2iii or defexer2 as the 

template for the new method.

a Select File > New > Method or click  and select Method.

The Method Wizard New Method panel appears.

b Click the Browse button and select exer2iii or defexer2 from the Method 
Template Selection dialog box.

c Enter ssmethiii in the New Method Name box.
d Select Sequence.

e Click Next until you reach the Data Analysis panel.
f Mark the Calibration and Quantitation, Custom Calculations and Include 

System Suitability check boxes.

g Click through the remaining panels, making appropriate selections until you 
have completed the Method Wizard.
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Advanced Exercise #8 Set up a Group Identifier with calculations for system suitability
2 Select an example chromatogram
• Use the example chromatogram 

you produced with Basic Exercise 
2a or 2b of the “Basic Exercise #3a 
Run a sequence to quantify 
compounds with single-level 
calibration” and “Basic Exercise 
#3b Reintegrate and reprocess the 
results”. 

• Or, use defexchrom2a.

a On the selection tree, expand the exer3iii folder.
b Expand the Data Analysis folder.
c Select the Example Chromatogram item.
d On the Tools toolbar, click .

e Select the sample name with the injection number to produce the example 
chromatogram.

f Click the Select button.

The example chromatogram appears in the workspace.

g After you have selected the example chromatogram, you can see the 
integration and identification settings that belong to the original method.

h Click Save if the Save Changes to the Database dialog box appears.

Steps Detailed Instructions
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Advanced Exercise #8 Set up a Group Identifier with calculations for system suitability
Task 2. Set up the custom calculations for the system suitability test

Steps Detailed Instructions

1 On the multi-injection summary 
worksheet, add a column to contain 
the resolution of each component.

a In the Data Analysis folder, select the Custom Calculator item.
b In the custom calculator workspace, click the Multi Injection tab.
c Right click in the worksheet and select Add Column from the context menu.

The Add Column dialog box appears.

d In the Existing Column tab, expand the Peaks section and select Peak 
resolution USP. Click OK to close the dialog box.

The workspace now contains a column with the peak resolutions for each 
injection for each component.

2 Add a column to contain the new 
calculation for the mean of the peak 
resolutions for the replicate 
injections.

a Right click in the worksheet and select Add Column from the context menu.

The Add Column dialog box appears.

b Click the Add a new Custom Calculation Column tab.
c Enter Mean Resolution (Injections) in the Display Name field. 
d Click the Level down arrow and select Compound.
e Set the Number of Decimals to 4.

The workspace now contains a column for the new variable Mean Resolution 
(Injections).
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Advanced Exercise #8 Set up a Group Identifier with calculations for system suitability
3 Enter the formula for the mean of the 
resolutions for the replicate 
injections for each compound.

a In each of the compound variables lines of the new column, enter the formula 
to average the resolutions of the replicate injections.

Hint: Use the syntax, =AVERAGE(D10:D12).

4 On the Group Identifier worksheet, 
add a new Group Identifier for the 
system suitability samples.

a Right click in the worksheet and select Add/Modify Group Identifiers from 
the context menu.

The Add/Modify Group Identifiers dialog box appears.

b Enter SySSuit in the New Group Identifier Name field and click Add.

c Click OK to close the Add/Modify Group Identifiers dialog box.
The workspace now contains new groups of lines under each section for the 
Group Identifier SysSuit.

Steps Detailed Instructions
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Advanced Exercise #8 Set up a Group Identifier with calculations for system suitability
5 On the Group Identifier worksheet, 
add a column to contain the mean 
resolution of each component.

a Right click in the worksheet and select Add Column from the context menu.

The Add Column dialog box appears.

b In the Existing Column tab, expand the User Defined section and select 
Mean Resolution (Injections). Click OK to close the dialog box.

The workspace now contains a column with the mean peak resolutions for each 
component. Note that the worksheet sets up sub-group identifiers for each 
component; this exercise does not use sub-group identifiers, so the only 
numbers of interest are under Sub group identifier #1 in each case. To simplify 
the worksheet, you can collapse the ... and Sub group identifier #2 rows for 
each compound.

6 Add a column to contain the new 
calculation for the mean of the peak 
resolutions for different samples.

a Right click in the worksheet and select Add Column from the context menu.

The Add Column dialog box appears.

b Click the Add a new Custom Calculation Column tab.
c Enter  Mean Resolution (Samples) in the Display Name field. 
d Click the Level down arrow and select Compound Variable (Group 

Identifier).

The workspace now contains a column for the new variable Mean Resolution 
(Samples).

Steps Detailed Instructions
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Advanced Exercise #8 Set up a Group Identifier with calculations for system suitability
7 Enter the formula for the mean of the 
resolutions across samples for each 
compound.

a In the SysSuit line of the new column for dimethylphthalate, enter the 
formula to average the resolutions of the samples.

Hint: Use the syntax, =AVERAGE(F22:F24).

b Extend the selection to include the SysSuit lines for each compound in the 
Mean Resolution (Samples) column.

Hint: Hold the left mouse button down while selecting the cells.

c Right click in the worksheet and select Fill Down from the context menu.

The formula is copied into each of the available cells.

8 Add a column to contain the new 
calculation for the standard 
deviation of the mean resolutions.

a Right click in the worksheet and select Add Column from the context menu.

The Add Column dialog box appears.

b Click the Add a new Custom Calculation Column tab.
c Enter StdDev Resolution in the Display Name field. 
d Click the Level down arrow and select Compound Variable (Group Identifier.

The workspace now contains a column for the new variable StdDev Resolution.

Steps Detailed Instructions
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Advanced Exercise #8 Set up a Group Identifier with calculations for system suitability
9 Enter the formula for the standard 
deviation of the mean resolutions.

a Select the SysSuit line of the new column for dimethylphthalate, right click in 
the worksheet and select Select Function from the context menu.

The Select Function dialog box appears.

b Expand the Statistical section, select Standard Deviation and click Select.

The STDDEV function is copied to the selected cell.

c Add the cell references for the standard deviation calculation:

The syntax is =STDEV(F22:F24).

d Fill down the column with the new calculation.

Steps Detailed Instructions
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Advanced Exercise #8 Set up a Group Identifier with calculations for system suitability
10 Add a column to contain the new 
calculation to be used for system 
suitability.

a Right click in the worksheet and select Add Column from the context menu.

The Add Column dialog box appears.

b Click the Add a new Custom Calculation Column tab.
c Enter Resolution Ratio in the Display Name field. 
d Click the Level down arrow and select Sample Variable (Group Identifier.

The workspace now contains a column for the new variable Resolution Ratio.

11 Enter the formula for the resolution 
ratio.

a In the SysSuit line of the new column for the Sample Group Variable, enter 
the formula to ratio the resolution of the o-terphenyl peak with that of the 
dimethylphthalate peak.

Hint: Use the syntax, =G62/G20.

Steps Detailed Instructions
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Advanced Exercise #8 Set up a Group Identifier with calculations for system suitability
Task 3. Set up the limit conditions

Steps Detailed Instructions

1 On the Group Identifier Limits panel, 
add a system suitability limit check:
• If the ratio is greater than 0.9, the 

check is passed; continue the run.

a In the Data Analysis folder, select the Limits item.
b In the Limits panel, click the Group Identifier tab.
c Right click in the table header and select Insert new limit from the context 

menu.

The Insert new limit dialog box appears.

d Expand the Sample Variable (Group Identifier) section and select Resolution 
Ratio.

e In the Limits group, set the following parameters:
• Data Set: SysSuit
• Apply To: Selected Variable ID
• Condition: >
• Value: 0.9
• Notification: Passed
• User Action: Continue

f Click OK to add the new limit check to the table.
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Advanced Exercise #8 Set up a Group Identifier with calculations for system suitability
2 Add two more system suitability 
limit checks:
• If the ratio is greater than 0.8 (but 

less than 0.9), give a warning, but 
continue the run.

• If the ratio is less than 0.8, the 
check is not passed; abort the run.

a For each limit check, display the Insert new limit dialog box, expand the 
Sample Variable (Group Identifier) section and select Resolution Ratio.

b Set the parameters to:
• Data Set: SysSuit
• Apply To: Selected Variable ID
• Condition: >
• Value: 0.8
• Notification: Warning
• User Action: Continue

and

• Data Set: SysSuit
• Apply To: Selected Variable ID
• Condition: <
• Value: 0.8
• Notification: Not Passed
• User Action: Abort

Steps Detailed Instructions
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Advanced Exercise #8 Set up a Group Identifier with calculations for system suitability
Task 3. Identify the system suitability samples in the sequence table

Steps Detailed Instructions

1 If necessary, prepare a sequence for 
the method.

a See “Task 1. Create a new sequence” on page 30.

2 Enter samples into the sequence 
table.

a See “Task 2. Enter sample and sequence information” on page 31.

3 Identify the system suitability test 
samples in the sequence table.

a Select the system suitability test sample line in the sequence table.
b In the Sample Entry tab of the workspace, click the Calculations tab.
c Click the Group Identifier down arrow and select SysSuit from the list.

The group identifier name is added into the Group Identifier column of the 
sequence table. Samples identified with this name will be used in the custom 
calculator worksheet and in the limits checks.
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In This Book

This Getting Started Guide 
is a collection of basic and 
advanced exercises that 
provide a quick way to 
learn the Cerity 
Pharmaceutical QA/QC 
application. 

The exercises are grouped 
into two groups: 

Running Routine Samples 
exercises help lab 
technicians learn how to 
run routine samples.

Setting up methods 
exercises help Chemists 
learn how to set up 
methods for the laboratory. 
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